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Read this manual before working with the product. For personal and system safety, and for 
optimum product performance, make sure you thoroughly understand the contents before 
installing, using, or maintaining this product.

Within the United States, Rosemount Inc. has two toll-free assistance numbers.
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 1-800-999-9307(�����������	������
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�
Technical support, quoting, and order-related questions.
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Equipment service needs.

1-800-654-7768 (����	���������������������������) 

For equipment service or support needs outside the United States, contact your local 
Rosemount representative.

The products described in this document are NOT designed for nuclear-qualified 
applications. 

Using non-nuclear qualified products in applications that require nuclear-qualified hardware 
or products may cause inaccurate readings. 

For information on Rosemount nuclear-qualified products, contact your local Rosemount 
Sales Representative.

This product is designed to meet FCC and R&TTE requirements for a non-intentional 
radiator. It does not require any licensing whatsoever and has no tank restrictions 
associated with telecommunications issues.

This device complies with part 15 of the FCC rules. Operation is subject to the following two 
conditions: (1) This device may not cause harmful interference, and (2) this device must 
accept any interference received, including interference that may cause undesired 
operation.
www.rosemount.com
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�.4��5�����.��� Procedures and instructions in this manual may require special precautions to 
ensure the safety of the personnel performing the operations. Information that 
raises potential safety issues is indicated by a warning symbol ( ). Refer to 
the saftey messages listed at the beginning of each section before performing 
an operation preceded by this symbol.
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• Make sure only qualified personnel perform the installation.

• Use the equipment only as specified in this manual. Failure to do so may 
impair the protection provided by the equipment.
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• Verify that the operating environment of the transmitter is consistent with the 
appropriate hazardous locations certifications.

• Before connecting a HART®-based communicator in an explosive atmosphere, 
make sure the instruments in the loop are installed in accordance with 
intrinsically safe or non-incendive field wiring practices.
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• Use extreme caution when making contact with the leads and terminals.

Any substitution of non-recognized parts may jeopardize safety. Repair, e.g. substitution 
of components etc., may also jeopardize safety and is under no circumstances allowed.
www.rosemount.com
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�.�%.���6��6��� This manual provides installation, configuration and maintenance information 
for the Rosemount 3300 Series Radar Transmitter.

��������!7���	�
��������������"

• Theory of Operation

• Descripton of the transmitter

• Process and vessel characteristics
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• Mounting considerations

• Mechanical installation

• Electrical installation
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• Configuration instructions

• Configuration using the HART Communicator

• Configuration using the RCT software
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• Display functionality

• Error messages
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• Advanced Configuration

• Error and Warning Codes

• Communication Errors
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• Specifications

• Ordering Information
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• Examples of labels

• European ATEX Directive information

• FM approvals

• CSA approvals

• Drawings
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• Features

• Connections

• Diagnostic messages
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�1���5��4��,��.���� The Rosemount 3300 Series Radar Transmitter is a smart, two-wire 
continuous level transmitter that is based on Time Domain Reflectometry 
(TDR) principles. Low power nano-second-pulses are guided along a probe 
immersed in the process media. When a pulse reaches the surface of the 
material it is measuring, part of the energy is reflected back to the transmitter, 
and the time difference between the generated and reflected pulse is 
converted into a distance from which the total level or interface level is 
calculated (see below). 

The reflectivity of the product is a key parameter for measurement 
performance. A high dielectric constant of the media gives better reflection 
and a longer measuring range. A calm surface gives better reflection than a 
turbulent surface.

Figure 2-1. Measurement 
Principle.
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.,,���.����� The Rosemount 3300 Series Radar Transmitter program is suited for 
aggregate (total) level measurements on most liquids, semi-liquids, and 
liquid/liquid interfaces. 

Guided microwave technology offers highest reliability and precision which 
ensure measurements are virtually unaffected by temperature, pressure, 
vapor gas mixtures, density, turbulence, bubbling/boiling, low level, varying 
dielectric media, pH, and viscosity.

Guided wave radar technology in combination with advanced signal 
processing make the 3300 transmitters suitable for a wide range of 
applications:

Figure 2-2. Application 
examples

Boiling conditions with 
vapor and turbulence. For 
these applications the 
Coaxial probe is particularly 
suitable.

The 3300 Series of 
transmitters is well suited 
for bridle applications such 
as distillation columns.
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Separator tank. The model 
3302 measures both level 
and interface level.

The Rosemount 3300 
series is a good choice for 
underground tanks since it 
is installed on the tank top 
with the radar pulse 
concentrated near the 
probe. It can be equipped 
with probes that are 
unaffected by high and 
narrow openings or nearby 
objects.

Guided wave radar 
technology is a good choice 
for reliable measurements 
in small ammonia, NGL and 
LPG tanks.
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The Rosemount 3300 Series Radar Transmitter has an aluminum �����������	

�����
 which contains advanced electronics for signal processing. 

The �����	����������� produces an electromagnetic pulse which is guided by 
the �����. 

There are different probe types available for various applications: Rigid Twin 
Lead, Flexible Twin Lead, Rigid Single Lead, Flexible Single Lead, and 
Coaxial. 

Figure 2-3. Transmitter 
components.

����
Flexible and Rigid probes require different radar electronics and can not be 
used with the same transmitter head.
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The Rosemount 3300 Series Radar Transmitter is loop-powered which 
means it uses the same two wires for both power supply and output signal. 
The output is a 4-20 mA analog signal superimposed with a digital HART 
signal.

By using the optional HART Tri-loop, it is possible to convert the HART signal 
to up to three additional 4-20 mA analog signals.

With the HART protocol it is possible to use multidrop configuration. In this 
case communication is restricted to digital since current is fixed to the 4 mA 
minimum value. 

The transmitter can be connected to display Model 751 Field Signal Indicator 
or it can be equipped with an integral display.

The transmitter can easily be configured by using a HART 275 Communicator 
or a PC with the Radar Configuration Tool software. Rosemount 3300 Series 
transmitters are also compatible with the AMS™ (Asset Management 
Solutions™) software which also can be used for configuration.

Figure 2-4. System architecture.
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Use the following guidelines to choose appropriate probe for your 3300 
transmitter:

Table 2-1.  Probe selection guide. G=Good, NR=Not Recommended, AP=Application Dependent (consult factory)

������� �����	(��
	!��� �����;��	(��
	!��� �����	4�
���	!��� �����;��	4�
���	!���

*��������
��

Level G G G G G

Interface (liquid/liquid) G G G NR NR

 ������	*�����	���������������

Changing density G G G G G

Changing dielectric(1) G G G G G

Wide pH variations G G G G G
Pressure changes G G G G G

Temperature changes G G G G G

Condensing vapors G G G G G

Bubbling/boiling surfaces G G AP G AP

Foam (mechanical 
avoidance)

AP NR NR NR NR

Foam (top of foam 
measurement)

NR AP AP AP AP

Foam (foam and liquid 
measurement)

NR AP AP NR NR

Clean liquids G G G G G

Liquid with dielectric<2.5 G AP AP NR AP

Coating liquids NR NR NR AP AP

Viscous liquids NR AP AP AP G

Crystallizing liquids NR NR NR AP AP
(�
�	�
"���
��
�	��
���������
�

Probe is close 
(<12 in./30 cm) to tank wall 
/ disturbing objects

G AP AP NR NR

High turbulence G G AP G AP

Turbulent conditions 
causing breaking forces

NR NR AP NR AP

Long and small mounting 
nozzles
(diameter <6 in./15 cm,
height>diameter + 4 in./10 
cm)

G AP NR NR NR

Probe might touch nozzle / 
disturbing object

G NR NR NR NR

Liquid or vapor spray might 
touch probe G NR NR NR NR

Disturbing EMC 
environment in tank

AP NR NR NR NR

567 &�
	���
���	�����	������������	�	�!�� �� 	�������
��	!��	��	������	��	�!�	�����
������	&�
	����
����	�����
������	�	�!�� �� 	�������
��	��	�!�	���	�����	
8���	�� 
���	�!�	����
���	��	�!�	����
����	�����
������
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*�	��;���
 The measuring range depends on probe type and properties of the product. 
The %&&���*�	��;��� is the minimum measurement distance between the 
upper reference point and the product surface. The Upper Dead Zone varies 
between 4 - 20 in. (0.1 and 0.5 m) depending on probe type and product.

At the end of the probe the measuring range is reduced by the ��"���*�	��
;���. The ��"���*�	��;����also varies depending on probe type and 
product.

Figure 2-5 illustrates how the measuring range is related to the Dead Zones:

Figure 2-5. Dead Zones

����
The measurement accuracy is reduced in the Dead Zones. It may even be 
impossible to make any measurements at all in those regions. Therefore the 
4-20 mA set points should be configured outside the Dead Zones.
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Table 2-2.  Dead Zones for different probe types
$���������	
��
���
�

�������	 ��;� �����	(��
	!���	
 ��;�

�����;��	(��
	
!���	 ��;�

4�
���	!���	
 ��;�

�����;��	4�
���	
!���	 ��;�

Upper Dead 
Zone

2 3.9 in. (10 cm) 7.9 in. (20 cm) 15.7 in. (40 cm) 13.8 in. (35 cm) 19.7 in. (50 cm)
80 3.9 in. (10 cm) 7.9 in. (20 cm) 11.8 in. (30 cm) 7.9 in. (20 cm) 11.8 in. (30 cm)

Lower Dead 
Zone

2 2 in. (5 cm) 2.8 in. (7 cm) 5.9 in. (15 cm) 3.9 in. (10 cm) 4.7 in. (12 cm)

80 1.2 in. (3 cm) 2 in. (5 cm) 2 in. (5 cm) 2 in. (5 cm) 2 in. (5 cm)
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The Rosemount 3300 Series has a high sensitivity due to its advanced signal 
processing and high signal to noise ratio, which makes it able to handle 
various disturbances. However, the following circumstances should be 
considered before mounting the transmitter.

��	���(� Coating on the probe should be avoided since the sensitivity of the transmitter 
may be decreased leading to measurement errors. In viscous or sticky 
applications, periodic cleaning may be required. 

0���(��( Heavy coating that results in product bridging across the two probes for twin 
lead versions, or between the pipe and the inner rod for coaxial probes, will 
cause erroneous level readings and must be prevented. Single lead probes 
are preferred in this case.

4�	� How well the Rosemount 3300 Series Radar Transmitter measures in foamy 
applications depends upon the properties of the foam; light and airy or dense 
and heavy, high or low dielectrics, etc. If the foam is conductive and creamy 
the transmitter will probably measure the surface of the foam. If the foam is 
less conductive the microwaves will probably penetrate the foam and 
measure the liquid surface.

6	&�� In some applications, as ammonia, there is heavy vapor above the product 
surface that will influence the level measurement. The Rosemount 3300 
Series Radar Transmitter can be configured to compensate for the influence 
of vapor.

��	

���(��	�(� The measuring range differs depending on probe type and characteristics of 
the application. The values given in ����� ��� can be used as a guideline for 
clean liquids.

Table 2-3.  Measuring Range

The maximum measuring range differs depending on application according 
to:

• Disturbing objects close to the probe.

• Media with higher dielectric constant (εr) gives better reflection and 
allows a longer measuring range.

• A calm surface gives better reflection than a turbulent surface. For a 
turbulent surface the measuring range might be reduced.

• Surface foam and particles in the tank atmosphere are also 
circumstances that might affect measuring performance.

• Coating/contamination can reduce the measuring range. 

������� �����	(��
	!��� �����;��	(��
	!��� �����	4�
���	!��� �����;��	4�
���	!���

*������	*������
�	��
��

19 ft 8 in. (6 m) 9 ft 10 in. (3 m) 65 ft 7 in. (20 m) 9 ft 10 in. (3 m) 65 ft 7 in. (20 m)

*�
����	$���������	��
���
�	��	*������	*������
�	��
��

1.6 1.9 2.0 (1.6 up to 10 m) 2.5 (2.0 if installed in 
a metallic bypass or 
stilling well)

2.8 (2.0 up to 10 m)
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������	�� Model 3302 is the ideal choice for measuring the interface of oil and water or 
other liquids with significant dielectric differences. It is also possible to 
measure interface with the Model 3301 in bridle/tank applications when the 
probe is fully immersed in the liquid.

Figure 2-6. Fully immersed 
probe

Rigid twin lead, flexible twin lead and coaxial probes can be used to measure 
interfaces. However, the coaxial probe is the preferred choice. For measuring 
the interface level, the transmitter uses the residual wave of the first reflection. 
Part of the wave, which was not reflected at the upper product surface, 
continues until it is reflected at the lower product surface. The speed of this 
wave depends fully on the dielectric constant of the upper product.

If interface is to be measured, the following criteria have to be fulfilled:

• The dielectric constant of the upper product must be known. The Radar 
Configuration Tools software has a built-in dielectric constant calculator 
to assist user´s in determining the dielectric constant of the upper 
product (see “Dielectrics” on page 4-21).

• The dielectric constant of the upper product must have lower dielectric 
constant than the lower product in order to have a distinct reflection.

• The difference between the dielectric constants for the two products 
must be larger than 10.

• Maximum dielectric constant for the upper product is 10 for the coaxial 
probe and 5 for twin lead probes.

• The upper product thickness must be larger than 8 inch (0.2 m) for the 
flexible twin lead probe and 4 inch (0.1 m) for the rigid twin lead and 
coaxial probes in order to distinguish the echoes of the two liquids.

The maximum allowable upper product thickness/measuring range is 
primarily determined by the dielectric constants of the two liquids. 

Target applications include interfaces between oil/oil-like and water/water-like 
liquids. For such applications the upper product dielectric constant is low (<3) 
and the lower product dielectric constant is high (>20), and the maximum 
measuring range is only limited by the length of the coaxial and rigid twin lead 
probes.

For the flexible twin lead probe, the reduction of maximum measuring range 
(65 ft/20 m), can be gained from Figure 2-7 on page 2-10..

However characteristics varies widely between different applications. For 
other product combinations, consult factory.
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Figure 2-7. Reduction of 
maximum measuring range for 
Flexible Twin Lead probe

��
�
�����	+��


Sometimes there is an emulsion layer (mix of the products) between the two 
products which, depending on its characteristics, will affect interface 
measurements.

For guidelines on emulsion situations, consult factory. 

6������
�1.�.����������

1�	���(�����
<�.(��	���
 The Rosemount 3300 Series Radar Transmitter is relatively insensitive to 
objects in the tank since the radar signal is transmitted along a probe. 

Avoid physical contact between probes and agitators as well as applications 
with strong fluid movement unless the probe is anchored. If the probe can 
move within 1 ft (30 cm) away from any object, such as an agitator, during 
operation then probe tie-down is recommended.

In order to stabilize the probe for side forces, it is possible to hang a weight at 
the probe end (flexible probes only) or fix/guide the probe to the tank bottom.

�	�=��)	&� The guided wave radar transmitter is insensitive to the tank shape. Since the 
radar signal travels along a probe, the shape of the tank bottom has virtually 
no effect on the measurement performance. The transmitter handles flat or 
dish-bottom tanks equally well. 

��������
	��	*������	*������
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��	���	
�������
�	<����	 ������	$���������	��
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	!���	���;�	7��5�8	

*������	<����	 ������	(����
���	7��5�8

IN
T

E
R

F
A

C
E

_R
E

D
U

C
T

IO
N

_S
C

A
LE

0

0�1

+

2-10



�����������	�
	��
00809-0100-4811, Rev AA
October 2002 Rosemount 3300 Series
�������� � ��
�	��	����
�	���+���

	(�
�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3 &	(���$ 
��
�	��	�����,�����
��� �3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3 &	(���$�
0������5�
���
�	����3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3 &	(���$#
��
����(����
����	����
� �3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3 &	(���$-
��������������
����(�,�
�������3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3 &	(���$ �
���)	���	����
�	��	����� �3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3 &	(���$  
��������	����
�	��	����� �3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3 &	(���$ -
�&����	��*�����
�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3 &	(���$!�

�.4��5�����.��� Procedures and instructions in this section may require special precautions to 
ensure the safety of the personnel performing the operations. Information that 
raises potential safety issues is indicated by a warning symbol ( ). Please 
refer to the following safety messages before performing an operation 
preceded by this symbol.

��������
�	�����	������	�
	�����	��	�������	�
����


Verify that the operating environment of the transmitter is consistent with the appropriate 
hazardous locations certifications.

Before connecting a HART-based communicator in an explosive atmosphere, make 
sure the instruments in the loop are installed in accordance with intrinsically safe or 
non-incendive field wiring practices.

Do not remove the gauge cover in explosive atmospheres when the circuit is alive.

�������	��	������	����	�
���������
	�
�	���"���
�	�������
��	�����	������	�
	�����	��	
�������	�
����


Make sure only qualified personnel perform the installation.

Use the equipment only as specified in this manual. Failure to do so may impair the 
protection provided by the equipment.

Do not perform any service other than those contained in this manual unless you are 
qualified.
www.rosemount.com
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Avoid contact with leads and terminals. 

Make sure the main power to the 3300 transmitter is off and the lines to any other 
external power source are disconnected or not powered while wiring the gauge.
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Follow these steps for proper installation:

����>
Disconnect power supply before setting the Write Protection.
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Electronic boards are electrostatically sensitive. Failure to observe proper 
handling precautions for static-sensitive components can result in damage to 
the electronic components. Do not remove the electronic boards from the 
3300 Radar Transmitter.

����
To ensure long life for your radar transmitter, and to comply with hazardous 
location installation requirements, tighten covers on both sides of the 
electronics housing.

The transmitter monitors its own operation. This automatic diagnostic routine 
is a timed series of checks repeated continuously. If the diagnostic routine 
detects a failure in the transmitter, the 4–20 mA output is driven upscale (high) 
or downscale (low) depending on the position of the Alarm switch.

Security write protection prevents unauthorized access to configuration data 
through the Rosemount Configuration Tool (RCT) software, a HART 275 
Communicator or Asset Management Solutions (AMS) software.

Table 3-1.  3300 Radar Transmitter Switch Settings

4�����	
3�
� $���������
 $������	4����
�  ������
	4����
��

Alarm 4–20 mA Alarm Output High High, Low

Write 
Protect

Security Write 
Protection

Disabled (OFF) ON = Enabled, 
OFF = Disabled

Table 3-2.  Analog Output: Standard Alarm Values vs. Saturation Values

!�"�� 9?+,	��	4��������
	>����� 9?+,	��	�����	>����

Low 3.9 mA 3.75 mA

High 20.8 mA 21.75 mA

Table 3-3.  Analog Output: NAMUR-Compliant Alarm Values vs. Saturation 
Values

!�"�� 9?+,	��	4��������
	>����� 9?+,	��	�����	>����

Low 3.8 mA 3.6 mA

High 20.5 mA 22.5 mA
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Figure 3-1. Switches for Alarm 
and Write Protection

To set the Alarm and Write Protect switches do the following:

1. Remove the cover on the circuit side (see main label).

2. To set the 4-20 mA alarm output to Low, move the Alarm switch to the 
LOW position. HIGH is the factory default setting (see Figure 3-1).

3. To enable the security write protection feature, move the Write Protect 
switch to the ON position. The OFF position is the factory default setting 
(see Figure 3-1).

4. Replace and tighten the cover.
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Before you install the Rosemount 3300 Series Radar Transmitter, be sure to 
consider specific mounting requirements, vessel characteristics and process 
characteristics.

,����

����������� The 3300 Series has a threaded connection for easy mounting on the tank 
roof. It can also be mounted on a nozzle by using different flanges.

�)��	��������������

Figure 3-2. Mounting on tank 
roof using threaded connection 

Mounting on tank roof.

Mounting in threaded pipe.
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Figure 3-3. Mounting in nozzles

The transmitter can be mounted in nozzles by using an appropriate flange. It 
is recommended that the nozzle size is within the dimensions given in 
����� ���. For small nozzles it may be necessary to increase the Upper Null 
Zone (UNZ) in order to reduce the measuring range in the upper part of the 
tank. By setting the UNZ equal to the nozzle height, the impact on the 
measurement due to interfering echoes from the nozzle will be reduced to a 
minimum. See also section �������������	��	�
�	���	��	�
�	�����	��	��
� ����. 
Amplitude Threshold adjustments may also be needed in this case.

����
Except for the Coaxial Probe the probe must not be in contact with the nozzle. 
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Table 3-4.  Minimum nozzle diameter and maximum nozzle height (inch/mm)

�����	(��
	!��� �����;��	(��
	!��� ������� 4�
���	!��� �����;��	4�
���

* ��� 4(100) 4(100) > Probe diameter 6(150) 6(150)

*!��� 2(50) 2(50) > Probe diameter 2(50)(3)

1.5(38)(4)
2(50)

1��� 4(100) + D(6) 4(100) + D(6) - 4(100) + D(6) 4(100) + D(6)

567 ����
	*���	9���:��
5;7 ����
	*���	9���<��	
5
7 �
�����	����������	6�=	���!
5>7 �
�����	����������	6	���!
5=7 �����������	��?����	��,,��	!�� !��	&�
	���?���	�
����	�!�
�	��	��	����������	��	��,,��	!�� !��
527 *�,,��	�������
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Figure 3-4. Mounting in 
Still Pipes.

�����	(��
	!����

Pipe diameter Ø≥2 inch (50 mm).
Inlet pipe diameter N<Ø.
L≥12 inch (300 mm).

The center rod must be placed more than 
0.6 inch/15 mm away from the pipe wall. 

�����	4�
���	!����

Pipe diameter Ø≥1 inch (25 mm).
Inlet pipe diameter N<Ø.
L≥12 inch (300 mm).

Make sure that the probe is at the center of 
the Still pipe.

����@ It is not recommended that flexible 
probes are installed in by-pass pipes.

�����;��	(��
	!����

Pipe diameter Ø≥3 inch (75 mm).

The center rod must be placed more than 
0.6 inch/15 mm away from the pipe wall. The 
probe may under no circumstances get into 
contact with the pipe wall.

�����;��	4�
���	!����

Pipe diameter Ø≥3 inch (75 mm).

Make sure that the probe is at the center of 
the Still pipe.

�������	!����

Pipe diameter Ø≥1.5 inch (38 mm).
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4�����&	�� For easy access to the transmitter make sure that it is mounted with sufficient 
service space. For maximum measurement performance the transmitter 
should not be mounted too close to the tank wall or other objects in the tank. 

If the probe is mounted close to a wall, nozzle or other tank obstruction noise 
might appear in the level signal. Therefore the following minimum clearance, 
according to the table below, must be maintained:

Figure 3-5. Free Space 
Requirement
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Table 3-5.  Recommended free space to tank wall

��	8�	� ��(����"�� 4��8������"�� ��(������(�� 4��8��������(��

0 in. (0 mm) 4 in. (100 mm) 4 in. (100 mm) 12 in. (300 mm) 12 in. (300 mm)
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When finding an appropriate mounting position for the transmitter the 
conditions of the tank must be carefully considered. The transmitter should be 
mounted so that the influence of disturbing objects is reduced to a minimum.

In case of turbulence the probe may need to be anchored to the bottom, see 
“Mechanical Installation“ on page 3-11 for more information.

Figure 3-6. Mounting Position

The following guidelines should be considered when mounting the transmitter:

• Do not mount close to inlet pipes.

• Do not mount close to agitators. If the probe can move within 30 cm 
away from an agitator a probe tie-down is recommended.

• If the the probe tends to sway due to turbulent conditions in the tank, 
fasten the probe to the tank bottom.

• Avoid mounting close to heating coils.

• Make sure that the nozzle does not extend into the tank.

• Make sure that the probe does not come into contact with the nozzle or 
other objects in the tank.

• Position the probe such that it is subject to a minimum of lateral force.
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Mount the transmitter with flange on a nozzle on top of the tank. The 
transmitter can also be mounted on a threaded connection. Make sure only 
qualified personnel perform the installation.

����
If you need to remove the transmitter head from the probe, make sure that the 
Process Seal is carefully protected from dust and water. See ������� ��	
��� ��� for further information.

Figure 3-7. Tank connection with 
flange.

Figure 3-8. Threaded tank 
connection.

1. Place a gasket on top of the tank flange.

2. Lower the transmitter and probe with 
flange into the tank. 

3. Tighten the bolts.

4. Loosen the nut that connects the 
transmitter housing to the probe slightly.

5. Rotate the transmitter housing so the 
cable entries/display face the desired 
direction.

6. Tighten the nut.
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1. For adapters with BSP/G threads, place 
a gasket on top of the tank flange.

2. Lower the transmitter and probe into the 
tank. 

3. Screw the adapter into the process 
connection. 

4. Loosen the nut that connects the 
transmitter housing to the probe slightly.

5. Rotate the transmitter housing so the 
cable entries/display face the desired 
direction.

6. Tighten the nut.
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1. Mark off the required probe 
length. Add at least 1.6 inch
/40 mm to the required probe 
length to be inserted into the 
weight.

2. Loosen the Allen screws. 

3. Slide the weight upwards as 
much as needed in order to cut 
the probe.

4. Cut the probe. If necessary, 
remove a spacer to make room 
for the weight.

5. Slide the weight down to the 
required cable length.

6. Tighten the screws.

7. Update the transmitter 
configuration to the new probe 
length, see “Probe Length“ on 
page 4-9.

If the weight was removed from the 
cables when cutting, make sure 
that at least 1.6 inch/40 mm of the 
cable is inserted when the weight is 
replaced. 
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1. Loosen the screw and remove 
the end piece.

2. Cut the rods to the desired 
length. Make sure that the thin 
rod is 0.6 inch/15 mm shorter 
than the other probe to make 
sure that they fit into the end 
piece.

3. Replace the end piece and 
tighten the screw.

4. Update the transmitter 
configuration to the new probe 
length, see “Probe Length“ on 
page 4-9.
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1. Cut the pipe to the desired 
length.

2. Cut the rod inside the pipe.

3. Update the transmitter 
configuration to the new probe 
length.

• Pipes longer than 49 
inches/1250 mm can be 
shortened by as much as 23.6 
inches/600 mm.

• Pipes shorter than 49 
inches/1250 mm can be cut as 
long as the remaining length is 
not less than 15.7 inches/400 
mm.
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.��)����( In turbulent tanks it may be necessary to fix the probe. Depending on the 
probe type different methods can be used to guide the probe to the tank 
bottom. This may be needed in order to prevent the probe from hitting the 
tank wall or other objects in the tank, as well as preventing a probe from 
breaking.

4��8������"��A���(�����	� probe 
with weight and ring.

A ring (customer supplied) can be 
attached to the weight in a threaded 
(M8x14) hole at the end of the 
weight. Attach the ring to a suitable 
anchoring point.

4��8������"��A���(�����	� probe 
with weight and magnet.

A magnet (customer supplied) can 
be fastened in a threaded (M8x14) 
hole at the end of the weight. The 
probe can then be guided by placing 
a suitable metal plate beneath the 
magnet.

��	8�	� probe fixed to the tank wall.

The coaxial probe can be guided to 
the tank wall by fixtures fastened to 
the tank wall. Fixtures are customer 
supplied. Make sure the probe can 
move freely due to thermal 
expansion without getting stuck in 
the fixture.
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��	8�	� probe.

The coaxial probe can be guided by 
a tube welded on the tank bottom. 
Tubes are customer supplied. Make 
sure that the probe can move freely 
in order to handle thermal expansion.

��(����"�����	� probe.

The rigid twin lead probe can be 
guided to the tank wall by a fixture at 
the lower end of the outer rod. The 
end piece needs to be moved 
accordingly by cutting the center rod. 
The length of the rod outside the end 
piece will add to the dead zone.

The fixture is customer supplied. 
Make sure the probe is only guided 
and not fastened in the fixture to be 
able to move freely for thermal 
expansion.

4��8��������(�����	� probe.

The probe rope itself can be used for 
anchoring. Pull the probe rope 
through a suitable anchoring point, 
e.g. a welded eye and fasten it with 
two clamps.

The length of the loop will add to the 
dead zone.The location of the 
clamps will determine the beginning 
of the dead zone. See section “Dead 
Zones“ on page 2-7 for further 
information on Dead Zones.
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 The electronics housing has two entries for ½ - 14 NPT. Optional M20×1.5 
and PG 13.5 adapters are also available. The connections are made in 
accordance with local or plant electrical codes.

Make sure that unused ports are properly sealed to prevent moisture or other 
contamination from entering the terminal block compartment of the electronics 
housing. 

����>
Use the enclosed metal plug to seal the unused port.

���
����( The housing should always be grounded in accordance with national and 
local electrical codes. Failure to do so may impair the protection provided by 
the equipment. The most effective grounding method is direct connection to 
earth ground with minimal impedance. There are two grounding screw 
connections provided. One is inside the Field Terminal side of the housing 
and the other is located on top of the housing. The internal ground screw is 
identified by a ground symbol: !

����>
Grounding the transmitter via threaded conduit connection may not provide 
sufficient ground.

�	������������� Use shielded twisted pair wiring for the Rosemount 3300 Series in order to 
comply with EMC regulations. The cables must be suitable for the supply 
voltage and approved for use in hazardous areas, where applicable. For 
instance, in the U.S., explosion-proof conduits must be used in the vicinity of 
the vessel. For the ATEX flame proof approval version of the 3300 Series, 
suitable conduits with sealing device or flame proof (EEx d) cable glands must 
be used depending on local requirements.

Use 18 AWG to 12 AWG in order to minimize the voltage drop to the 
transmitter.

1	2	���

�.��	
 When the 3300 transmitter is installed in hazardous area, local regulations 
and specifications in applicable certificates must be observed.
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,�"�����B
�������
 Terminals in the transmitter housing provide connections for signal cables.

The 3300 transmitter is loop-powered and operates with power supplies 
ranging from 11 to 42 VDC. For Intrinsically Safe output the supply voltage 
must be within 11 to 30 VDC. For Explosion Proof/Flame Proof the supply 
voltage must be within 16 to 42 VDC.

�	8��
�����&�
��
�
�	���

The maximum current loop resistance can be gained from the following 
diagrams:

Figure 3-9. Explosion/Flame 
Proof installations

Figure 3-10. Non-hazardous 
installations

Figure 3-11. Intrinsically Safe 
installations
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The 3300 Series is a two-wire loop powered transmitter. It accepts power 
supplies ranging from 11 VDC to 42 VDC. It uses 4-20 mA power 
superimposed with a HART signal.

To connect the transmitter:

1. Make sure that power supply is disconnected.

2. Remove the cover on the transmitter housing terminal side (see label).

3. Pull the cable through the cable gland/conduit.

4. Connect wires according to Figure 3-12 for non-intrinsically safe output 
and according to Figure 3-13 for Intrinsically safe output.

5. Replace the cover, tighten the cable gland and connect the power 
supply.

���$������
��	��+��	���
�
�&
�

For non-intrinsically safe installations wire the transmitter as shown in 
Figure 3-12. 

����>
Make sure that the power supply is off when connecting the transmitter.

Figure 3-12. Wiring diagram for non-intrinsically safe installations.

The HART 275 Communicator requires a minimum load resistance of 250 
Ohm within the loop in order to function properly. For maximum load 
resistance see Figure 3-9 (Explosion/Flame Proof) and Figure 3-10 
(Non-hazardous installations).

The power supply voltage ranges from Vmin VDC to 42 VDC where Vmin	is the 
minimum voltage given by:

For Explosion Proof/Flame Proof applications the resistance between the 
negative terminal on the transmitter and the power supply must not exceed 
300 Ohm.
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�&
� For intrinsically safe installations wire the transmitter as shown in Figure 3-13.

����>
Make sure that the instruments in the loop are installed in accordance with 
intrinsically safe field wiring practices.

Figure 3-13. Wiring diagram for 
intrinsically safe installations

The HART 275 Communicator requires a minimum load resistance within the 
loop of 250 Ohm in order to function properly. For maximum load resistance 
see Figure 3-11. 

The power supply voltage ranges from 11 V to 30 V.
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Ui=30 V.

Ii=130 mA.

Pi=1 W.

Ci=0.

Li=0.
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���$���& The Model 3300 transmitter outputs a HART signal with four process 
variables. By using the Model 333 HART Tri-Loop up to three additional 
analog 4-20 mA outputs are provided.

Figure 3-14. Wiring diagram for 
HART Tri-Loop

Configure Channels 1, 2, and 3 to reflect the units as well as Upper Range 
Values and Lower Range Values for your secondary, tertiary and fourth 
variables (variable assignment is configured in the Model 3300). It is also 
possible to enable or disable a channel from this menu. See “Special 
Functions“ on page 4-24 for further information on how to install a Tri-Loop.
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The 3300 transmitter can be run in multidrop mode. In the multidrop mode 
each transmitter has a unique HART address.

Figure 3-15. Multidrop 
connection

The poll address can be changed by using a HART 275 Communicator or by 
using the Rosemount Configuration Tools software.

To change the poll address using a 275 Communicator choose HART 
command [1, 4, 5, 2, 1].

To change the poll address using the Rosemount Configuration Tools (RCT) 
software do the following:

1. Choose the View>Device Commands option.
or
choose the Device Commands icon from the Project Bar Advanced 
section.

2. Open the Details folder.

3. Choose the Set Poll Address option.

4. Set the desired address.
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�.4��5�����.��� Procedures and instructions in this section may require special precautions to 
ensure the safety of the personnel performing the operations. Information that 
raises potential safety issues is indicated by a warning symbol ( ). Refer to 
the safety messages listed at the beginning of each section before performing 
an operation preceded by this symbol.

��������
�	�����	������	�
	�����	��	�������	�
����


Verify that the operating environment of the gauge is consistent with the appropriate 
hazardous locations certifications.

Before connecting a HART-based communicator in an explosive atmosphere, make 
sure the instruments in the loop are installed in accordance with intrinsically safe or 
non-incendive field wiring practices.

Do not remove the gauge cover in explosive atmospheres when the circuit 
is alive.

�������	��	������	����	�
���������
	�
�	���"���
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��	�����	������	�
	�����	��	
�������	�
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Make sure only qualified personnel perform the installation.

Use the equipment only as specified in this manual. Failure to do so may impair the 
protection provided by the equipment.

Do not perform any service other than those contained in this manual unless you are 
qualified.
www.rosemount.com
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The Model 3301 transmitter can be configured for level and volume 
measurements. The Model 3302 is designed to measure interface level and 
interface distance as well. 

The Rosemount 3300 transmitter can be pre-configured according to the 
ordering specifications in the Configuration Data Sheet.

0	
��������(
�	���� The basic transmitter configuration includes setting the tank geometry 
parameters. For interface measurements the dielectric constant of the top 
liquid must also be given. For some applications with heavy vapor, the vapor 
dielectric must be given as well.

Figure 4-1. Tank Geometry

Figure 4-2. Upper Reference 
Point

For the different tank connections the Upper Reference Point is located at the 
underside of the threaded adapter or at the underside of the welded flange, as 
illustrated in Figure 4-2:
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The Reference Gauge Height is the distance from the Upper Reference Point 
to the bottom of the tank. The transmitter measures the distance to the 
product surface and subtracts this value from the Reference Gauge Height to 
determine the level.

,��������(�)

The probe length is the distance between the Upper Reference Point and the 
end of the probe. If a weight is used at the end of the probe it shall not be 
included.

This parameter is pre-configured at factory. It must be changed if the probe is 
shortened.

,������+&�

The transmitter is designed to optimize measurement performance for each 
probe type. 

This parameter is pre-configured at factory. This value needs to be changed if 
the probe type is changed.

Flexible and Rigid probes require different radar electronics and can not be 
used with the same transmitter head.

*�������������
�	������%&&���,���
��

For interface measurements the dielectric constant of the upper product is 
essential in order to obtain good accuracy. See section “Interface” on 
page 2-9 for further information on dielectric constants. 

If the dielectric constant of the lower product is significantly smaller than the 
dielectric constant of water, you may need to make special adjustments. See 
section “Interface Measurements for Semi-Transparent Bottom Products” on 
page 6-5 for further information. 

For level measurements the Upper Product Dielectric parameter corresponds 
to the actual dielectric constant of the product in the tank. Normally this 
parameter does not need to be changed even if the actual dielectric constant 
of the product deviates from the Upper Product Dielectric parameter value. 
However, for some products measurement performance can be optimized by 
setting the proper product dielectric constant.

*�������������
�	������6	&��

In some applications there is heavy vapor above the product surface having a 
significant influence on the level measurement. In such cases the vapor 
dielectric can be entered to compensate for this effect.

The default value is equal to 1 which corresponds to the dielectricity of 
vacuum. Normally this value does not need to be changed since the effect on 
measurement performance is very small for most vapors.

%&&����
���;���

This parameter should only be changed if there are measurement problems in 
the upper part of the tank. Such problems may occur if there are disturbing 
objects close to the probe. By setting the Upper Null Zone the measuring 
range is reduced. See �������	��	������������	��	�
�	���	��	�
�	���� for 
further information.
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The 4 mA point should be set above the Lower Dead Zone (see �������	��	
����	"����). If the 4 mA point is set to a point within the Dead Zone or below 
the probe end, the full range of the analog output is not used.

!���.�&����

Make sure that the 20 mA point is below the Upper Null Zone. 

The 20 mA point should be set below the Upper Dead Zone (see �����	
"����#	��	��
� ��$). If the 20 mA point is set to a point within the Dead Zone 
the full range of the analog output is not used.

,�����	�(��

If the transmitter is not mounted vertically the angle from vertical position must 
be given. 
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�	���� For volume calculations you can choose one of the standard tank shapes or 
the strapping option. Choose None if volume calculation is not used.

�	�=��+&�

You can choose one of the following options:

• Strap table

• Vertical Cylinder

• Horizontal Cylinder

• Vertical Bullet

• Horizontal Bullet

• Sphere

• None

���	&&��(��	���

Use a strapping table if a standard tank type does not provide sufficient 
accuracy. Use most of the strapping points in regions where the tank shape is 
non-linear. A maximum of 10 points can be added to the strapping table.

Figure 4-3. Strapping points
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Figure 4-4. Standard tank 
shapes

6�����	���+������

Vertical Cylinder tanks are specified by 
Diameter and Height.

1���2���	���+������

Horizontal Cylinders are specified by 
Diameter and Height.

6�����	��0
����

Vertical Bullet tanks are specified by 
Diameter and Height. The volume 
calculation model for this tank type 
assumes that the radius of the bullet 
end is equal to the Diameter/2.

1���2���	��0
����

Horizontal Bullets are specified by 
Diameter and Height. The volume 
calculation model for this tank type 
assumes that the radius of the bullet 
end is equal to the Diameter/2.

�&)���

Spherical tanks are specified by 
Diameter.
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This section describes how to configure the 3300 transmitter by using a HART 
275 Communicator.

Appendix A provides brief instructions on the use of the HART Communicator. 
For information on all the capabilities, refer to the HART Communicator 
Product Manual.

Figure 4-5. The HART 275 
Communicator.
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Figure 4-6. HART Communicator Menu Tree
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9 Measurement 
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�
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0.�������4��%�.���� This section describes the various HART commands used to configure the 
3300 Series of transmitters for level measurements. The transmitter outputs a 
4 - 20 mA signal proportional to the primary variable. Three additional 
variables are available through the HART signal.

��	�
�������6	��	���


You may assign up to four transmitter variables. Typically, the primary variable 
(PV) is configured to be Aggregate Level, Interface Level or Volume. 

For the model 3301 the primary variable is typically set to be Level. If the 
transmitter is in the Immerse Probe mode (see section “Measurement Mode” ) 
the PV is normally set to Interface Level.

For the model 3302 the PV is typically set to Interface Level, but Level and 
other options may also be used. 

��	�
�������%���


Set transmitter units for level and temperature.

�����������	
(��1��()�

The Reference Gauge Height is the distance from the Upper Reference Point 
to the bottom of the tank (see Figure 4-1 on page 4-2). When setting the 
Reference Gauge Height, keep in mind that this value is used for all level 
measurements performed by the 3300 Series transmitter. 

The Reference Gauge Height must be set in linear (level) units, such as feet 
or meters, regardless of primary variable assignment.

,��������(�)

The probe length is the distance from the Upper Reference Point to the end of 
the probe, see Figure 4-1. If the probe is anchored to a weight do not include 
the height of the weight. This parameter is pre-configured at factory. The 
Probe Length needs to be changed if for example the probe is shortened.

%��(	���� 1, ,1 ,1, 1

%��(	���� 1, 3, 2

%��(	���� 1, 3, 4

%��(	���� 1, 3, 5
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The transmitter automatically makes an initial calibration based on the type of 
probe that is used. This parameter is pre-configured at factory and only needs 
to be set if the probe is changed to another type. Choose one of the following 
options:

• Rigid Twin Lead

• Flexible Twin Lead

• Coaxial

• Rigid Single Lead

• Flexible Single Lead

����
Flexible and Rigid probes require different radar electronics and can not be 
used with the same transmitter head.

,���
���*���������

For interface measurements the dielectric constant of the upper product is 
essential for calculating the interface level and the upper product thickness. 
By default the Product Dielectric parameter is about 2. 

If the dielectric constant of the lower product is significantly smaller than the 
dielectric constant of water, you may need to make special adjustments. See 
section �%��������	&�����������	���	����������������	'�����	(�������#	��	
��
� ��) for further information.The dielectric constant of the product is used 
for setting the appropriate signal amplitude thresholds, see �������	��	��� ���	
���	��������
�����
 for more information on amplitude threshold settings. 
Normally this parameter does not need to be changed for level 
measurements. However, for some products measurement performance can 
be optimized by setting the proper product dielectric constant.

The Rosemount Configuration Tool (RCT) software includes a Dielectric Chart 
wich lists the dielectric constants of a wide range of products. RCT also 
includes a tool which allows you to calculate dielectric constants based on 
measurements of the Upper Product Thickness.

6	&���*���������

In some applications there is heavy vapor above the product surface having a 
significant influence on the level measurement. In such cases the vapor 
dielectric can be entered to compensate for this effect.

The default value is equal to 1 which corresponds to the dielectric constant of 
vacuum. Normally this value does not to be changed since the effect on 
measurement performance is very small for most vapors.

%��(	���� 1, 3, 6

%��(	���� 1, 3, 8

%��(	���� 1, 3, 7
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Normally the Measurement Mode does not need to be changed. The 
transmitter is pre-configured according to the specified model:

%��������	%�������	(���� is used for applications where the probe is fully 
immersed in liquid. In this mode the transmitter ignores the upper product 
level. See �������	��	%��������	������������	*��
	����+	��������	������ for 
more information.

����>
Only use %��������	%�������	(���� for applications where interface is 
measured for a fully immersed probe.

,�����.�(��

Enter the angle between the probe and the vertical line. The default value is 
equal to zero. Do not change this value if the transmitter is mounted with the 
probe along the vertical line (which is normally the case).

�	8��
��%&&���,���
���
�)��=��

 For interface measurements the Maximum Upper Product Thickness 

parameter may be used in special cases when the dielectric constant of the 
upper product is relatively high. By setting this parameter you can avoid that 
interface measurements are getting out of range.

*	�&��(

The default Damping value is 10. Normally this value does not need to be 
changed. The Damping parameter determines how quickly the transmitter 
responds to level changes and how robust the measurement signal is against 
noise. See �,�

	-� ��	.����#	��	��
� ��$ for more information.

*�
&�	+�&	���

Choose which variables to be displayed and the desired language to be used. 
The display toggles between the selected variables every two seconds.

%��(	���� 1, 3, 9

Table 4-1.  Measurement Mode
*���� *��������
�	*���

3301  �����(1), ��������� ���������
�	 �

567 @������	������ 

3302 �����!��������������������(1), ��������� ���������
�	 �

%��(	���� 1, 3, 11

%��(	���� 1, 3, 12

%��(	���� 1, 4, 4, 4

%��(	���� 1, 4, 2
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When setting the range values, it is possible to enter the values directly using 
the keypad on the HART 275 Communicator, or you may use actual values 
(HART command [1, 3, 3, 1]). Keep in mind that the 20 mA value should be 
below the Upper Dead Zone. If the 20 mA point is set to a point within the 
Dead Zone the full range of the analog output is not used.

Also make sure that the 20 mA value is below the Upper Null Zone (UNZ). 
(This parameter may be used if there are measurement problems in the upper 
part of the tank, see �������	��	������������	��	�
�	���	��	�
�	����). The UNZ 
is equal to zero in the default configuration.

The 4 mA point should be above the Lower Dead Zone. If the 4 mA point is 
set to a point within the Dead Zone or below the probe end (tank bottom for 
example), the full range of the analog output is not used.

See Section 2: Dead Zones for more information on the size of Upper and 
Lower Dead Zones.

Figure 4-7. Range Values

%��(	���� 1, 3, 3, 2
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��	�
�������6	��	���


Select the Volume option in order to configure the transmitter for volume 
measurements.

6��
���%���


Choose one of the following units:

• Gallons

• Liters

• Imperial Gallons

• Cubic Meters

• Barrels

• Cubic Yards

• Cubic Feet

• Cubic Inch

�	�=��+&�

Choose a standard tank shape, or select the strapping option. Standard 
shapes are: Vertical Cylinder, Horizontal Cylinder, Vertical Bullet, Horizontal 
Bullet or Sphere. (If Primary Variable is Level choose None for Tank Type).

If your tank does not correspond to any of the above tank shapes, select Strap 
Table.

�	�=�*����
���


If a standard tank type was chosen, enter the diameter and height of the tank. 
See “Volume Configuration” on page 4-5 for information on how to specify 
tank dimensions.

���	&&��(��	���

If tank type Strapping Table was chosen, enter how many entries you will use 
and the actual level and volume points. You can enter from 2 to 10 points. The 
strapping points must be entered such that the first point corresponds to the 
lowest level, and the last point corresponds to the topmost level of the tank.

%��(	���� 1, 1, 1, 1

%��(	���� 1, 3, 2, 2

%��(	���� 1, 4, 3, 1

%��(	���� 1, 4, 3, 2

%��(	���� 1, 4, 3, 4
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The Radar Configuration Tool (RCT) is a user-friendly software tool that 
allows you to configure the 3300 transmitter. You can choose either of the 
following two methods to configure a 3300 transmitter: 

• Start the Wizard for a guided installation if you are un-familiar with the 
3300 transmitter.

• Use the Setup function if you are already familiar with the configuration 
process or if you just want to change the current settings.

��
�	����(��)������

���"	��

To install the Rosemount Configuration Tool:

1. Insert the installation CD into your CD-ROM drive.

2. If the installation program is not automatically started, from the windows 
Start Bar choose Run and type D:\���
&3�8� where D is the CD-ROM 
drive.

3. Follow the instructions on the screen.

To start the RCT:

1. From the Start menu click Programs>RCT Tools>RCT.

2. In the RCT Status Bar check that RCT communicates with the 
transmitter:

�&����+��(��)������,��� If communication is not established open the HART Communication Server 
window and check that the right COM Port is selected.

To check the current COM port settings do the following:

1. Locate the HART Server icon in the lower right corner of the screen.

2. Double-click the HART Server icon.

�����
������
	��	����;������	7����
	���;��8

�����
������
	��	
��	����;������	7���	���;��8

%��(	4��"��	���
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Figure 4-8. RHCS Server 
window

3. Check the COM port.

4. Choose the COM Port option that matches the COM Port connected to 
the transmitter.

5. If communication is intermittent, increase '��+	.������ and /����	.������ 
to 5 and 5 respectively.

6. Click the Search for a device icon in the RCT tool bar:

1��&������� Help is accessed by pressing the F1 key or by selecting the Contents option 
from the Help menu. If the F1 key is pressed a help text appears with 
information about the window that is currently open. If a menu option is 
selected a help text appears with information about that particular menu.
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&���2	��� To install a 3300 transmitter by using the installation ��2	�� do the following:

Figure 4-9. RCT workspace

Figure 4-10. RCT Wizard

1. Start the RCT software.

2. In the RCT workspace click the 
Wizard icon (make sure that the 
Basic section is open),
or
choose the View>Wizard menu 
option.

3����

6�G���
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3. Click the ��	�� button and follow the 
instructions. Now you will be guided 
through a number of dialogs 
allowing you to configure the 
transmitter. 
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&�
4
������

To install a 3300 transmitter by using the ���
& function do the following:

Figure 4-11. RCT workspace

Figure 4-12. Setup Info

����
When working with the Setup window keep in mind that for all tabs except the 
Info tab, data is updated by clicking the Receive button. To download data to 
the transmitter click the Send button.

1. Start the RCT software.

2. In the RCT workspace click the 
Setup icon (make sure that the 
Basic area is open),
or
choose the View>Setup menu 
option.

4����

3����
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3. Choose the appropriate tab:

����: information about the device.

0	
��
: Set Probe Type and 
measurement units.

.�	��(: Variable assignment and 
range value settings.

�	�=������(: Tank height and other 
geometry settings, dielectric 
constants for vapor and upper 
product.

6��
��: specification of tank 
geometry for volume calculations.

��*: display panel settings.
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���
&�$����� The ����� tab shows information about the connected transmitter.

Figure 4-13. Setup Title tab

Device Name: designation of the current transmitter model.
EPROM ID:current transmitter database version.
Device Type: designates the transmitter type. 33 is used for the 3300 Series.
Device ID: a unique identifier for each 3300 Series transmitter.
Hardware Rev: the current revision of the transmitter electronic board.
Software Rev:the current revision of the transmitter software that controls 
measurement, communication, internal checks etc. 

���
&�$�0	
��
 The 0	
��
 tab lets you choose ��	

�������%���
 for Level, Volume and 
Temperature. These units are used wherever measurement and configuration 
data is presented.

Figure 4-14. Setup Basic tab

This window also allows you to enter some general information about the 
transmitter like Message, Tag, Descriptor and Date. This information is not 
required for the operation of the transmitter and can be left out if desired.
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���
&�$��
�&
� The �
�&
� tab lets you assign up to four transmitter variables

Figure 4-15. Setup output tab

Typically, the ,���	�+�6	��	��� (PV) is configured to be Product Level, 
Interface Level or Volume.

Other variables like Product Distance, Interface Distance, Upper Product 
Thickness, etc. are available as well.

For model 3301 the primary variable is typically set to be Level. If the 
transmitter is in the Immersed Probe mode (see section 
“Measurement Mode” ) the PV is normally set to Interface Level.

For the model 3302 the PV is typically set to Interface Level, but Level and 
other options may also be used.

Set the ��"����	�(��6	�
� (4 mA) and the %&&����	�(��6	�
� (20 mA) to 
the desired values. Keep in mind that the 20 mA value should be below the 
Upper Dead Zone, and the 4 mA point should be above the Lower Dead Zone 
if you want to use the full 4-20 mA range within the measuring range of the 
transmitter.

Also make sure that the 20 mA value is set below the Upper Null Zone (UNZ). 
(the UNZ parameter may be used if there are measurement problems in the 
upper part of the tank, see �������	��	������������	��	�
�	���	��	�
�	����). The 
UNZ is equal to zero in the default configuration.

See �������	��	����	"���� for more information on Upper and Lower Dead 
Zones. 

See �������	��	'����	0����
������� for more information on setting the Upper 
and Lower Range values.

The default *	�&��( value is 10. Normally this value does not need to be 
changed. The Damping parameter may be changed if there are high filling 
rates, see “High Level Rates” on page 6-7 for more information.
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���
&�$��	�=������( The �	�=������(
�	�����tab contains information on tank geometry 
parameters and dielectrics.

Figure 4-16. Setup Tank 
Configuration tab

�	�=��������+

The �����������	
(��1��()� is the distance from the Upper Reference 
Point to the bottom of the tank (see Figure 4-1 on page 4-2). When setting the 
Reference Gauge Height, keep in mind that this value is used for all level and 
volume measurements performed by the 3300 transmitter. 

The Reference Gauge Height must be set in linear (level) units, such as feet 
or meters, regardless of primary variable assignment.

The %&&����
���;��� (UNZ) should not be changed unless there are 
disturbances at the top of the tank. By increasing the Upper Null Zone value 
measurements in this region can be avoided. See �������	��	������������	��	
�
�	���	��	�
�	���� for more information on how to use the UNZ. The UNZ is 
equal to zero in the factory configuration.

,����

The 3300 Series transmitter automatically makes some initial calibrations 
based on the chosen ,������+&�. The following Probe Types are available:

• Twin Lead

• Flexible Twin Lead

• Coaxial

• Rigid Single Lead
• Flexible Single Lead

����
Flexible and Rigid probes require different radar electronics and can not be 
used with the same transmitter head

The ,��������(�) is the distance from the Upper Reference Point to the end 
of the probe, see Figure 4-1. If the probe is anchored to a weight do not 
include the height of the weight.

The ,�����.�(�� is the angle between the probe and the vertical line. Set 
this value equal to zero if the transmitter is mounted with the probe along the 
vertical line (which is normally the case).
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�����������

Normally the Measurement Mode does not need to be changed. The 
transmitter is pre-configured according to the specified model:

%��������	%�������	(���� is used for applications where the probe is fully 
immersed in liquid. In this mode the transmitter ignores the upper product 
level. See “�������	��	%��������	������������	*��
	����+	��������	������” for 
more information.

����>
Only use %��������	%�������	(���� for applications where interface is 
measured for a fully immersed probe.

*���������


In some applications there is heavy vapor above the product surface having a 
significant influence on the level measurement. In such cases the 6	&���
*��������� can be entered to compensate for this effect.

The default value is equal to 1 which corresponds to the dielectric constant of 
vacuum. Normally this value does not need to be changed since the effect on 
measurement performance is very small for most vapors.

For interface measurements the dielectric constant of the upper product is 
essential for calculating interface level and the upper product thickness. By 
default the %&&�� ,���
���*��������� parameter is about 2. 

If the dielectric constant of the lower product is significantly smaller than the 
dielectric constant of water, you may need to make special adjustments. See 
section �%��������	&�����������	���	����������������	'�����	(�������#	��	
��
� ��) for further information.

The dielectric constant of the product is used for setting the appropriate signal 
amplitude thresholds, see �������	��	��� ���	���	��������
�����
 for more 
information on amplitude threshold settings. Normally this parameter does not 
need to be changed for level measurements. However, for some products 
measurement performance can be optimized by setting the proper product 
dielectric constant.

RCT contains tools to estimate the dielectric constant of the current product:

• The *�����������)	�� lists the dielectric constant of a large number of 
products. Use one of the two following methods to view the Dielectric 
Chart:
- Choose the View>Dielectric>Dielectric Chart menu option. 
- Click the Dielectric Chart icon in the Project Bar Advanced section.

• The *�����������	��
�	��� lets you calculate the dielectric constant of 
the Upper Product based on the following input:
- actual upper product thickness,
- the dielectric constant value stored in the transmitter, and
- the upper product thickness presented by the transmitter.

Table 4-2.  Measurement Mode
*���� *��������
�	*���

3301  �����(1), ��������� ���������
�	 �

567 @������	������ 

3302 �����!��������������������(1), ��������� ���������
�	 �
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���
&�$�6��
�� The 6��
���tab lets you configure the transmitter for volume calculations.

Figure 4-17. Setup Volume tab

You can choose one of the standard tank shapes or the strapping option. 
Choose None if volume calculation is not used at all.

Choose one of the following options:

• Vertical Cylinder

• Horizontal Cylinder

• Vertical Bullet

• Horizontal Bullet

• Sphere

• Strap table

• None

See �������	��	1�����	0����
������� for more information on Volume 
configuration.
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���
&�$���* The ��* tab lets you specify which parameters to appear on the display 
panel. The display has two rows, the upper row with five characters is for the 
measured value and the lower row with six characters for the value name. 
The display toggles between the different variables every 2 seconds.

Figure 4-18. Setup LCD tab

Choose one of the following options:

Table 4-3.  LCD parameters

 �������� $���������


Level Product level.

Distance Distance from the upper reference point to the product surface.

Volume Total product volume.

Internal Temperature Temperature inside the transmitter housing.

Interface Distance Distance between the upper reference point and the interface 
between the upper and lower product.

Interface Level Level of the lower product.

Interface Thickness Thicknes of the upper product.

Amplitude Peak 1 Signal amplitude of the reflected signal from the reference pulse.

Amplitude Peak 2 Signal amplitude of the reflected signal from the product surface.

Amplitude Peak 3 Signal amplitude of the reflected signal from the surface of the 
bottom product (interface measurements).

Percent Range Level value in percent of total measurement range.

Analog Output Current 4 -20 mA current.
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������& The Model 333 HART Tri-Loop HART-to-Analog Signal Converter is capable 
of converting a digital HART burst signal into three additional 4-20 mA analog 
signals. This is a brief description of how to connect the HART Tri-Loop to the 
Model 3300 transmitter.

1. Configure the 3300 transmitter.

2. Assign transmitter variables Primary Variable, Secondary Variable etc.
HART command [1,1,1,1].
RCT: Setup>Output tab.

3. Configure variable units: Length, Volume and Temperature. 
HART command [1,3,2,1-3].
RCT: Setup>Basics tab.
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4. Put the 3300 in Burst mode.
HART command [1, 4, 5, 2, 3].
RCT: Device Commands>Details>Set Burst Mode option.

5. Select Burst option 3=Process variables and current (Process vars/crnt).
HART command [1,4,5,2,4].

6. Install the Tri-Loop. Connect channel 1 wires, and optionally wires for 
Channel 2 and Channel 3.

7. Configure Tri-Loop Channel 1:

a. Assign variable: Tri-Loop HART command [1,2,2,1,1].
Make sure that the SV, TV, and QV match the configuration of the 
3300 transmitter.

b. Assign units: Tri-Loop HART command [1,2,2,1,2]. Make sure that 
the same units are used as for the 3300 transmitter.

c. Set the Upper Range Value and the Lower Range Value: Tri-Loop 
HART command [1,2,2,1,3-4].

d. Enable the channel. Tri-Loop HART command [1,2,2,1,5].

8. (Optional) Repeat steps a-d for Channels 2 and 3.

9. Connect wires to Tri-Loop Burst Input.

10. Enter the desired tag, descriptor and message information:
Tri-Loop HART command [1,2,3].

11. (Optional) If necessary, perform an analog output trim for Channel 1 (and 
Channel 2 and 3 if they are used).
Tri-Loop HART command [1,1,4].

Figure 4-19. Tri-Loop wiring.

See the reference manual for the &����	���	,2.�	����-���	,2.�����2����
	
��
���	0�� ����� for further information on how to install and configure the 
Tri-Loop.
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&�	+�,	���
*�
&�	+�4
������	���+��3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3 &	(��'$ 
��������

	(�
�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3 &	(��'$!

*��,�.5�
4%������.���5

The 3300 transmitter uses the display for presentation of measurement 
variables. The display has two rows, the upper row with five characters is for 
the measured value and the lower row with six characters for the value name 
and measurement unit. The display toggles between the different variables 
every 2 seconds. Variables to be presented are configurable by using a HART 
275 Communicator or by using the Radar Configuration Tools software.

Figure 5-1. Presentation of 
measurement data

Model 3300 can display the following variables:

• Level

• Distance

• Volume

• Internal Temperature

• Interface Distance

• Interface Level

• Amplitude 1, 2 and 3 (see chapter 6 for more information)

• Interface Thickness

• Percent of range

• Analog current out
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����������.��� The display can alos be used for presentation of software errors. The upper 
row shows error codes and the lower row shows ’ERROR’.

Figure 5-2. Presentation of error 
messages 

The following errors can be displayed:

See also “Errors.” on page 6-20.

.�.���.�*�������
,���������

When mounting the Integral Display panel it is important that the Alarm and 
Write Protection switches on the transmitter mother board are correctly set. 
Make sure that the Alarm switch is in the HIGH position and the Write 
Protection switch is in the OFF position, see Figure 5-3. See also ������� ��	
'�����	3��	%������ for more information.

Figure 5-3. Alarm and Write 
Protection switches.

Once the mother board positions are set, then the display positions become 
the master.

���� �����

CNFIG Invalid Configuration

00001 Ram Failure

00002 ROM Checksum

00006 Waveform Acquisition Failure

00007 EEprom Factory Checksum

00010 Software Error

00013 Probe Failure
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	(�
�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3 &	(��-$ 
.��	����������(
�	����� �3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3 &	(��-$!
�������� 3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3 &	(��-$E
*�	(��
������

	(�
� 3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3 &	(��-$ E

�.4��5�����.��� Procedures and instructions in this section may require special precautions to 
ensure the safety of the personnel performing the operations. Information that 
raises potential safety issues is indicated by a warning symbol ( ). Please 
refer to the following safety messages before performing an operation 
preceded by this symbol.

��������
�	�����	������	�
	�����	��	�������	�
����


Verify that the operating environment of the gauge is consistent with the appropriate 
hazardous locations certifications.

Before connecting a HART-based communicator in an explosive atmosphere, make 
sure the instruments in the loop are installed in accordance with intrinsically safe or 
non-incendive field wiring practices.

Do not remove the gauge cover in explosive atmospheres when the circuit is alive.

�������	��	������	����	�
���������
	�
�	���"���
�	�������
��	�����	������	�
	�����	��	
�������	�
����


Make sure only qualified personnel perform the installation.

Use the equipment only as specified in this manual. Failure to do so may impair the 
protection provided by the equipment.

Do not perform any service other than those contained in this manual unless you are 
qualified.

%���	"������	����	���	;�	�����
�	�
	�����	�����	�����	����������	�����


Avoid contact with leads and terminals. 

Make sure the main power to the Rosemount 3300 Transmitter is off and the lines to any 
other external power source are disconnected or not powered while wiring
the gauge.
www.rosemount.com
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This section covers non-standard configuration.

%
�����������%&&���
����������,����

If you want to specify your own Upper Reference Point you can do this by 
setting the 0����������	4����� parameter. 

Figure 6-1. Tank Geometry

To set the desired upper reference point do the following:

1. Adjust the �����������	
(��1��()� to the distance from the tank 
bottom to the desired %&&�������������,����.

2. Add the the distance between the %&&�������������,���� and the 
��	�
�����������������,�����to the Calibration Offset value that is 
stored in the transmitter database. 
With the HART Communicator the Calibration Offset is available as 
HART Fast Key sequence [1, 3, 7].
In Radar Configuration Tool (RCT) the Calibration Offset is available 
under the Advanced section in the RCT Project Bar:
Device Commands>Basic>Set Calibration Offset.
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The Radar Configuration Tool (RCT) has powerful tools for advanced 
troubleshooting. By using the Waveform Plot function you get an instant view 
of the tank signal. Measurement problems can be solved by studying the 
position and amplitude of the different pulses.

To plot the measurement signal:

1. Start the Radar Configuration Tool program.

2. Choose the 6��">,������( menu option, or choose the Plotting icon in 
the RCT workspace (Advanced page at the left side of the workspace) 
and click the Read button.

Figure 6-2. Waveform plot in RCT

In a typical measurement situation the following pulses appear in the diagram:

,  - Reference pulse. This pulse is caused by the transition between 
transmitter head and probe. It is used by the transmitter as a reference at 
level measurements.

,! - Product surface. This pulse is caused by a reflection on the product 
surface. In Measurement Mode=Interface when Immersed Probe however, P2 
indicates the interface since the surface of the upper product is ignored.

,� - Interface or probe end. This pulse is caused by reflection on the interface 
between an upper product and a bottom product with a relatively high 
dielectric constant. It may also be caused by the probe end if there is no 
product above. This pulse is shown when the transmitter is in Measurement 
Mode=Level & Interface.

Different amplitude thresholds are used in order to filter out unwanted signals. 
The following amplitude thresholds are used for the 3300 transmitter:

�  - amplitude threshold for detection of the Reference pulse P1.

�! - amplitude threshold for detection of the product level peak P2.

�� - amplitude threshold for detection of the interface level peak P3.

�# - amplitude threshold that is used to detect whether the probe is fully 
immersed in the upper product or not.

Normally the thresholds are adjusted to approximately 50% of the signal peak 
amplitdue. To adjust the .�&���
����)��
)���
 open the Advanced section 
in the RCT Project Bar and choose Device Commands>Details>Set Nominal 
Thresholds.
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The Waveform plot can be automatically logged and saved to file by 
specifying the read plot interval and the number of plots to log.

Figure 6-3. Disk logging 
Waveform plot

The ��	��,����������	� entry field specifies the time interval between plots 
that are saved to disk. For example, type 10 if you want the waveform plot to 
be updated every ten minutes.

�
��������&���
������( specifies the maximum number of plot files that will 
be stored. The default value is 100.

Click the ��	���*�
=���((��( button to start the log. Make sure that Read 
Action type is set to Multiple Read. Otherwise RCT will only save one log file. 
Choose a destination folder and enter a file name. For each new file the 
corresponding number is appended to the end of the file name.

4����	����	�����
�

4����	��
�����
�

���;��	��	�����

����	����	�
���"��

����	�����
	����
6-4



�����������	�
	��
00809-0100-4811, Rev AA
October 2002 Rosemount 3300 Series
������	�����	

������
�
��������$��	�
&	�����
0������,���
��


In interface applications where the bottom product has a low dielectric 
constant, or if the signal is attenuated in the upper product, the amplitude of 
the reflected signal is relatively low and difficult for the transmitter to detect. In 
such a case it may be possible to detect the reflected signal if the 
corresponding amplitude threshold is adjusted.

The Radar Configuration Tool (RCT) lets you view a waveform plot to analyze 
the measurement signal. The plot shows the signal and the thresholds used 
for the different amplitude peaks. By adjusting amplitude threshold T3 it is 
possible to detect even weak interface signals. 

Guidelines for amplitude threshold settings:

• The amplitude threshold T3 should be approximately 50 % of the 
interface signal amplitude.

• Threshold T3 should not be less than 3.

• If possible, T3 should be higher than T2.

You can use the RCT software or a HART 275 Communicator to change the 
amplitude thresholds. For the HART Communicator use the HART command 
[1, 4, 6, 2]. See also “Amplitude Threshold Settings” on page 6-13.

RCT lets you view a plot of the measurement signal along with the current 
thresholds:

1. From the 6��" menu choose the ,������( option, or double-click the 
Plotting icon in the Advanced section of the RCT Project Bar. 

2. Click the Read button .

3. To adjust the .�&���
����)��
)���
 open the Advanced section in the 
RCT Project Bar and choose Device Commands>Details>Set Nominal 
Thresholds.

Figure 6-4. Waveform plot 
indicating that the amplitude 
threshold for the interface peak 
is too high.
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Figure 6-4 illustrates a situation where amplitude threshold T3 is too high. The 
signal amplitude peak at the interface between the upper and lower products 
is not detected in this case. By adjusting amplitude threshold T3, the peak at 
the interface between the upper and lower products is detected as illustrated 
in Figure 6-5:

Figure 6-5. After changing the 
amplitude threshold the 
transmitter detects the interface
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1�()��������	��
 The measurement signal is filtered in order to minimize the influence of 
disturbing noise. In most measurement situations this has no noticeable effect 
on the response time to level changes. If high level rates occur it may 
however be necessary to reduce the damping value in order to allow the 
transmitter to respond quicker. If there is too much noise the damping value 
may be increased in order to get a stable measurement signal.

You can use the RCT software or a HART 275 Communicator to change the 
Damping value. For the HART Communicator use the key sequence 
[1, 4, 4, 4]. 

In the RCT software open the ���
&>�
�&
� tab and enter the desired 
Damping value:

The Damping parameter determines how quickly the transmitter responds to 
level changes and how robust the measurement signal is against noise. 
Technically, a damping value of 10 means that in 10 seconds the output from 
the transmitter is about 63% of the new level value. Consequently, when there 
are rapid level changes in the tank, it may be necessary to decrease the 
Damping value for the transmitter to be able to track the surface. On the other 
hand, in noisy environments, and if level rates are low, it may be better to 
increase the damping value to have a stable output signal.
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The 3300 series has a measurement option which makes it possible to handle 
interface measurements when the product level is not visible, for example in a 
full bridle pipe as illustrated in Figure 6-6. In this case the probe is fully 
immersed into the upper product, and only the interface level is detected by 
the transmitter. Even if the upper product level drops, it is ignored by the 
transmitter which continues to measure only the interface level, but the 
measurement accuracy is reduced since the transmitter does not take into 
account the influence of the air gap above the product surface. 

The Measurement Mode parameter is available via the 
HART command [1, 3, 9]. Choose the %��������	*
��	%�������	(����	option.

Measurement mode %��������	*
��	%�������	(���� can also be activated in 
the RCT software:

1. Open the Setup window.

2. Select the Tank Config tab.

3. Choose Measurement Mode %��������	*
��	%�������	(����.

4. Click the Send Page button.

����>
Do not use Measurement Mode %��������	*
��	%�������	(����	in “standard” 
applications when both Interface Level and Product Level are measured.

If the product level drops, the air filled region in the upper part of the pipe will 
slightly reduce the measurement accuracy of the interface level. To achieve 
high accuracy in this measuement mode the probe must be fully immersed.

Figure 6-6. Interface Level 
measurements in a full bridle 
pipe.
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Adjust Threshold T2 if the level pulse is not detected.
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To calibrate the Analog Output current do the following:

1. Start RCT and make sure that the transmitter communicates with the PC 
(see Section 4: Installing the RCT software).

2. Open the Advanced section in the RCT workspace Project Bar and click 
the Device Commands icon,
or
choose the Device Commands option from the View menu.

3. Open the folder named Diag and double-click the Fixed Current Mode 
option.

4. Set the output current to 4 mA.

5. Measure the output current.

6. Open the folder named Details.

7. Choose the Trim DAC Zero option and enter the measured output 
current.

8. In the Diag folder double-click the Fixed Current Mode option and set the 
output current to 20 mA.

9. Measure the output current.

10. In the Details folder double-click the Trim DAC Gain option and enter the 
measured output current.

11. In the Diag folder double-click the Fixed Current Mode option and set the 
output current to 0 mA in order to leave the Fixed Current mode.
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When calibrating the transmitter it is important that the product surface is calm 
and that the tank is not being filled or emptied.

A complete calibration is performed in two steps:

1. Calibrate the Distance measurement by adjusting the Calibration Offset 
parameter.

2. Calibrate the Level measurement by adjusting the Reference Gauge 
Height.

*�
�	�����	����	����

1. Measure the actual distance between the Upper Reference Point and the 
product surface.

2. Adjust the Calibration Offset so that the Distance measured by the 
transmitter corresponds to the actual distance. 
The Calibration Offset parameter is available via 
HART command [1, 4, 6, 4],
or,
RCT: open the Advanced section in the Project Bar and choose Device 
Commands>Basics>Set Calibration Offset.

�������	����	����

1. Measure the actual Product Level.

2. Adjust the Reference Gauge Height so that the measured Product Level 
corresponds with the actual level.

Figure 6-7. Distance and Level 
calibration
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4. If the new probe is not of the same type as the original probe, update the 
transmitter configuration by setting the Probe Type parameter to the 
appropriate value: 
HART Fast Key sequence [1, 3, 6],
or
RCT Setup/Tank Config.

5. Measure the probe length and enter the measured value:
HART Fast Key sequence [1, 3, 5],
or
RCT Setup/Tank Config.

6. Verify that the transmitter is calibrated.

����
Flexible and Rigid probes require different radar electronics and can not be 
used with the same transmitter head.

1. Loosen the nut.

2. Remove the old probe from the 
transmitter head and mount the 
new probe.

3. Fasten the nut again.
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If there are measurement problems in the upper part of the tank it may be 
necessary to avoid measurements range in this region. Problems may occur if 
for example the nozzle diameter is too small or if there are disturbing objects 
close to the probe. By using the Upper Null Zone parameter, the measuring 
range in this region is reduced by avoiding measurements above a certain 
level.

Figure 6-8. Upper Null Zone

To set the Upper Null Zone do one of the following:

1. Select the HART command [1, 4, 4, 5].

2. Enter the desired value.

or

1. Start the �	�	�������(
�	��������� (RCT).

2. Click the Setup icon in the RCT workspace Project Bar.

3. Choose the �	�=������( tab in the Setup window.

4. Click the Receive Page button.

5. Type the desired value in the Upper Null Zone field.

6. Click the Send Page button. Now the Upper Null Zone is stored in the 
transmitter memory.

Figure 6-9. Using the Waveform 
Plot in RCT to set the Upper Null 
Zone
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The amplitude thresholds are automatically adjusted to appropriate values in 
order to filter out noise and other non-valid measurements from the 
measurement signal.

The amplitude of the measurement signal, i.e. the amplitude of the signal that 
is reflected by the product surface, is related to the actual dielectric constant 
of the product. The amplitude threshold that is used by the transmitter is 
based on the parameter configuration of the current product dielectric 
constant (see ������� ��	'����	0����
�������). Normally no other threshold 
adjustment is needed, but if the transmitter still does not track the product 
surface correctly it may be necessary to adjust the threshold values.

The Radar Configuration Tool (RCT) has a plot function allowing you to view 
the reflections along the probe.

If the amplitude threshold is too high the product level is not detected as 
illustrated in Figure 6-10.

Figure 6-10. Example 1: 
amplitude threshold T2 is too 
high.

If there are disturbing objects in the tank the threshold must be carefully set in 
order to avoid locking on the wrong amplitude peak. In Figure 6-11 the 
transmitter has locked on a peak above the actual product surface, i.e. a 
disturbance was interpreted as the product surface, whereas the actual 
product surface was interpreted as an interface or the probe end. 

Figure 6-11. Example 2: 
amplitude threshold T2 is too 
low.
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By adjusting the amplitude threshold T2 the product surface is detected 
correctly as illustrated in Figure 6-12.

Figure 6-12. Waveform plot after 
threshold T2 was adjusted 

To adjust the amplitude thresholds select HART command [1, 4, 6, 2] 

or

1. Start the Radar Configuration Tool (RCT).

2. Choose the *����������	��
 option from the View menu.

3. Open the *��	��
 folder.

4. Click the ���������	���)��
)���
�option.

The thresholds T2 and T3 should be set to about 50% of the measured signal 
amplitude for the product surface and the interface peaks, respectively. 

����
Amplitude thresholds should not be set to values less than 3.

����
Check that the dielectric constant parameter setting is reasonably close to the 
actual dielectric constant value of the upper product before changing the 
amplitude thresholds.

����
Default Amplitude thresholds can be set by typing 0 as the new threshold 
value.
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To start logging do the following:

1. Click the Monitor icon in the RCT workspace or choose the &������ 
option from the 1��* menu.

2. Choose the desired variables to be monitored and click the Start Monitor

button.

�	���(��)����(������
=

1. Choose the desired variables to be monitored.

2. Click the Log interval button and enter a time interval. For example, 
type 10 if you want data to be logged every tenth second.

3. Click the Counter button and enter the maximum number of files to be 
stored. The Counter is used to limit the amount of data stored on the 
hard disk. Each time the maximum number of entries in a log file is 
reached, the current log file is saved and a new file is created. This 
procedure continues up to the maximum number of files given by the 
Counter value. The file size is limited to 60000 entries which can easily 
be handled by spreadsheet programs like MS Excel.

4. Select the desired options for Timer, Time and Date. By selecting a 
check box the corresponding time indication is stored for each log entry 
in the log file.

5. Click the Start disk logging button.

6. Choose a destination folder and enter a file name.
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The Radar Configuration Tool offers different methods to save the current 
transmitter configuration:

• Save only the configuration specified in the Setup window. 

• Use the more extensive function in the Memory Map window.

You can use a stored configuration file as a backup of the current 
configuration, or it can be distributed for service purposes.

To save the current transmitter setup do the following:

1. Click the Setup icon in the RCT workspace or choose the ����� option 
from the 1��* menu to open the Setup window.

2. Click the right mouse button and choose the ��������.�� option,
or
from the Setup menu choose the ��������.�� option.
Alternatively, you can use the Receive Page option on each individual 
page.

����>
All pages must be received before the setup can be saved. 

3. Click the right mouse button and choose the �	������
& option.
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4. Choose a destination folder and enter a file name.

5. Click the �	�� button.

�����	��	�
��
&

1. Click the Setup icon in the RCT workspace or choose the ����� option 
from the 5��� menu.

2. In the ����� window click the right mouse button and choose the �&���
���
& option, or
from the 5��� menu choose the �&������
& option.

3. Open the source folder and select the desired setup file.

4. Click the �&�� button.

�����+��	&

The Memory Map window lets you view the current transmitter database 
registers. It is also possible to save the current database for backup or service 
purposes, and it is also possible to download a backup database to the 
transmitter. To save configuration data in the Memory Map window:

1. Start the RCT program.

2. Choose the 6��"F�����+ option, or click the �����+��	& icon in the 
RCT workspace (Advanced section at the left side of the workspace 
window).

3. Choose the All EE option from the drop-down list.

4. Click the Receive button. (It may take a few minutes to read the 
database).

5. Click the right mouse button and choose the Save Memory As option.

6. Type the desired file name and click the OK button. Now the current 
database is stored.

See the Online Help in RCT for further information on how to open a saved 
database and how to download a database to the transmitter.
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1. Losen the nut that connects the 
transmitter housing to the Process Seal.

2. Carefully lift the transmitter head.

3. Attach the protection plug to the Process 
Seal.
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Do not remove the Process Seal from the 
adapter!
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)�����( If there is a malfunction despite the absence of diagnostic messages, see 
Table 6-1 for information on possible causes.

Table 6-1.  Troubleshooting 
chart

4������  ����;��	����� �����


No HART communication. • COM Port configuration does not match 
the connected COM Port.

• Cables may be disconnected.
• Wrong HART adderss is used.
• Hardwafe failure.

• Check that correct COM Port is 
selected in the HART server (see 
“Specifying the COM Port” on 
page 4-14.

• Check wiring diagram.
• Verify that the 250 Ohm resistor is in 

the loop.
• Check cables.
• Make sure that correct HART short 

address is used. Try address=0.
• Check Analog Output current value to 

verify that transmitter hardware works.

Analog Out is set in Alarm. Use the command “Read Gauge Status” 
in order to check active errors.

Both P2 and P3 are detected but Interface 
Level is reported as Not A Number (NAN) 
in the waveform plot.

Measurement Mode is set to “Level Only”. Set Measurement Mode to “Level and 
Interface” (see “Basic Configuration” on 
page 4-9).

Both Level and Interface Level are 
reported as NAN.

Probe is not connected. Use the command “Read Gauge Status” 
and check if error “Probe Failure” is 
active. If this is the case, check the probe 
connection.

Both P2 and P3 are detected but the 
interface level is equal to the product 
Level.

• P3 is identified as a double bounce.
• P2 and P3 are very close.

Adjust thresholds T2 and T3, see 
“Amplitude Threshold Settings” on 
page 6-13 for more information.

P2 is detected but Level is incorrectly 
reported as Full or Empty.

Use the command “Read Gauge Status” 
and check if the warning “Probe 
Immersed” is active. If this is the case 
check that:

• the transmitter is configured with 
correct probe type,

• the reference pulse (P1) is below 
amplitude threshold T4. If not, adjust 
T4 to an appropriate value.

The reference pulse is not detected. • The tank is full.
• The transmitter is configured with 

wrong probe type.
• Amplitude Threshold T1 is not correct.

• Check the product level.
• Check that correct probe type is 

configured.
• Check Amplitude Threshold T1.

Level accuracy seems off. • Configuration error. • Check the Reference Gauge Height 
parameter.

• Check status information and 
diagnostic information.

Integral display does not work. • Check the display configuration.
• Check loop power.
• Check Display connection.
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3 Table 6-2 is a list of diagnostic messages that may be displayed on the 
Integral Display, on the Model 275 HART Communicator, in AMS or by the 
Radar Configuration Tools (RCT) software. Errors normally result in Analog 
Output alarm.

Errors are indicated in RCT by the message “Transmitter malfunction”:

To see the error message do one of the following:

• Click the Read Gauge Status icon in the toolbar at the top of the 
RCT workspace.

• 1. Open the Advanced section in the RCT workspace Project Bar and 
click the Device Commands icon, 
or 
choose the Device Commands option from the View menu.
2. Open the folder named Diag and double-click the Read Gauge 
Status option.

Table 6-2.  Error messages.
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Invalid configuration. At least one configuration parameter 
is outside allowed range. 
NOTE: the default values are used 
until the problem is solved.

• Load default database and restart 
the transmitter.

• Contact Saab Rosemount service 
department if the problem persists.

RAM failure was 
detected during 
startup test.

The transmitter performs an 
immediate reset.

Contact Rosemount service 
department.

FPROM failure was 
detected during 
startup test.

The transmitter performs an 
immediate reset.

Contact Rosemount service 
department.

Waveform acquisition 
failure.

This error is probably caused by 
hardware failure.

Contact Rosemount service 
department.

EEPROM factory 
checksum.

Checksum error in the factory 
configuration parameters. Can be 
caused by power failure during 
configuration or by hardware error. 
NOTE: the default values are used 
until the problem is solved.

Contact Rosemount service 
department.

EEprom user 
checksum error.

Caused by error in the User 
Configuration parameters. Can be 
caused by power failure during 
configuration or by hardware error.
NOTE: the default values are used 
until the problem is solved

• Load default database and restart 
the transmitter.

• Contact Saab Rosemount service 
department if the problem persists.

Software error.  Contact Rosemount service 
department.

Probe failure. Probe is not detected. Check that the probe is correctly 
mounted.
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3 Table 6-3 is a list of diagnostic messages that may be displayed on the 
Integral Display, on the Model 275 HART Communicator or by the Radar 
Configuration Tools (RCT) software. Warnings are less serious than errors 
and in most cases do not result in Analog Output alarms.

Warnings are indicated by a message at the bottom of the RCT workspace. To 
see the warning message do one of the following:

• Click the Read Gauge Status icon in the toolbar at the top of the 
RCT workspace.

• 1. Open the Advanced section in the RCT workspace Project Bar and 
click the Device Commands icon, 
or
choose the Device Commands option from the View menu.
2. Open the folder named Diag and double-click the Read Gauge 
Status option.

Table 6-3.  Warning messages.

*������ $���������
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Reference pulse not 
found.

Possible cause:
• Reference pulse immersed in 

high dielectric liquid.
• Wrong threshold level T1.
• Hardware error.

• View the waveform plot and check 
amplitude threshold T1.

• Check that the tank is not overfull.

No level pulse is 
found.

Possible cause:
• Wrong threshold level T2.
• Liquid level in Dead Zone or 

below probe end.
• View the waveform plot and 

check amplitude threshold T2.

Interface pulse not 
found.

Possible cause:
• Wrong threshold level T3.
• Interface level too close to the 

upper product level.
• No level pulse detected.

• View the waveform plot and 
check amplitude threshold T3.

Internal temperature 
out of range.

-40 ºC<Internal Temperature<85 ºC. Contact Rosemount service 
department.

Volume computation 
warning. 

• Volume configuration error.
• Strapping table error.

• Check that correct tank type is 
selected for volume configuration.

• Check that tank dimensions for 
volume are correct.

• If strapping table is used, check the 
level vs. volume points.

Immersed probe. • Wrong threshold level T4.
• Reference pulse immersed in 

liquid.

• View the waveform plot and check 
amplitude threshold T4.
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Product Rosemount Series 3300 Guided Wave Radar Level and Interface 
Transmitter; 
Model 3301 for Level (Interface available for fully immersed probe).
Model 3302 for Level and Interface.

Measurement principle Time Domain Reflectometry (TDR).

Reference Conditions Twin Lead probe, 77 °F (25 °C) water
Microwave Output Power Nominal 50 µW, Max. 2 mW.

CE-mark Complies with applicable directives (R&TTE, EMC, ATEX)

$������	5	��
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Integral Display The integral display toggles between the following variables: level, 
distance, volume, internal temperature, interface distance, interface level, 
peak amplitudes, interface thickness, percent of range, analog current 
output.
Note! The Integral Display can not be used for configuration purposes.

Output Units For Level, Interface and Distance: ft, inch, m, cm or mm.
For Volume: ft3, inch3, US gals, Imp gals, barrels, yd3, m3 or liters.

Output Variables Model 3301: Level, Distance (to product surface) and Volume. With fully 
immersed probe: Interface Level and Interface Distance.
Model 3302: Level, Distance (to product surface), Volume, Interface Level, 
Interface Distance and Upper Product Thickness.

HART device for remote confifguration Rosemount hand-held communicator Model 275.

PC for remote configuration Radar Configuration Tools software package.
Rosemount AMS software.

��������

Power supply Loop-powered (2-wire), 11 - 42 VDC (11 -30 VDC in IS applications, 16-42 
VDC in Explosion Proof/Flame Proof applications).

Output Analog 4 - 20 mA, HART.

Signal on alarm Standard: Low=3.75 mA. High=21.75 mA.
Namur NE 43: Low=3.60 mA. High=22.50 mA.

IS parameters Ui = 30 V,li= 130 mA, Pi = 1 W, Li=0, Ci=0.

Cable entry ½ - 14 NPT for cable glands or conduit entries.
Optional: M20 x 1.5 conduit adapter or PG 13.5 conduit adapter.

Output Cabling Twisted shielded pairs, 18-12 AWG..
www.rosemount.com
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Probes Coaxial: 1.3 ft (0.4 m) to 19.7 ft (6 m).
Rigid Twin Lead: 2 ft (0.6 m) to 9.8 ft (3 m).
Flexible Twin Lead: 3.3 ft (1 m) to 65.6 ft (20 m).
Rigid Single Lead: 2 ft (0.6 m) to 9.8 ft (3 m).
Flexible Single Lead: 3.3 ft (1 m) to 65.6 ft (20 m).
For further information see “Ordering Information” on page A-8.

Material exposed to tank atmosphere 316/316L SST (EN 1.4404), Teflon (PTFE, PFA) and O-ring materials (see 
ordering information).

Dimensions See “Dimensional drawings” on page A-3.
Probe angle 0 to 90 degrees from vertical axis.

Housing / Enclosure Polyurethane-covered Aluminium.

Flanges, Threads See “Ordering Information” on page A-8.

Height above flange See “Dimensional drawings” on page A-3.

�
"���
��
�

Ambient temperature -40 °F to +185 °F ( -40 °C to +85 °C), depends on approval (see App. B). 
For the LCD display the temperature range is 
-4 °F to +185 °F (-20 °C to +85 °C).

Process temperature -40 °F to +302 °F ( -40 °C to +150 °C).

Process pressure Full vacuum to 580 psig ( -1 to 40 Bar). 

Humidity 0 - 100 % relative humidity

Ingress protection NEMA 4X, IP 66.

Telecommunication (FCC and R&TTE) FCC part 15 (1998) subpart B and R&TTE (EU directive 97/23/EC).

Factory sealed Yes.
Vibration resistance DIN EN 60068-2-64, IEC 68-2-64, ANSI/ISA-571.03 SA1, VC2.

Electromagnetic compatibility Emission and Immunity: meets EN 61326-1 (1997) and amendment A1, 
class A equipment intended for use in industrial locations if installed in 
metallic vessels or still-pipes.
When rigid/flexible single and twin lead probes are installed in plastic or 
wood silos influence of strong electromagnetic fields might affect 
measurements.

Built-in Lightning Protection Meets EN 61000-4-4 Severity Level 4 and EN 61000-4-5 Severity Level 4.

Pressure Equipment Directive (PED) Complies with 97/23/EC article 3.3 (confirmed by DNV).
Ordinary Location FM 3810, Compliance.

Boiler Approval CSA B51-97 Compliance.

*������
�	 �������
��

Reference accuracy ± 0.2 inch (5 mm) for probes ≤ 16.4 ft (5 m) and
± 0.1% of measured distance for probes >16.4 ft (5 m).

Repeatability ± 0.04 inch (1 mm).

Ambient Temperature Effect Less than 0.01 % of measured distance per °C.

Update interval 1 per second

Measuring range 8 inch (0.1 m) to 65 ft (20 m).
A-2
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Figure A-1. Rigid Twin Lead 

Dimensions are in inches (millimeter).
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Figure A-2. Flexible Twin Lead

Dimensions are in millimeter (inches).
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Figure A-3. Coaxial

Dimensions are in inches (millimeter).
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Figure A-4. Flexible Single Lead

Dimensions are in inches (millimeter).
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Figure A-5. Rigid Single Lead

Dimensions are in inches (millimeter).
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3301 Guided Wave Radar Level Transmitter (interface only available for fully immersed probe)

���� 4��
��	)�����

H 4-20 mA with HART communication

���� %����
�	*�������

A Polyurethane-covered Aluminum

���� ��
����	(������5��;��	(������

1
2
3

½ - 14 NPT
M20x1.5 adapter
PG 13.5 adapter

���� )������
�	(����������	�
�	 �������

S -15 psi (-1 Bar) to 580 psi (40 Bar) @ 302 °F (150 °C) (1)

567 �
�����	����	
���� �	&����	
���� 	�������	��	���� �	���	)A
�� 	����������

���� *�������	��	��
��������

	 ������	��

�����
5 ��;�

1 316 / 316L SST (EN 1.4404), Teflon (PTFE, PFA)

���� 4����
�-	):��
�	*�������	7��
����	�������	���	�����	�:��
�	���������8

V
E
K
B

Viton
Ethylene Propylene
Kalrez 6375
Buna-N

����  ��;�	(���  ������	��

�����
  ��;�	!�
���

1A Rigid Twin Lead. Flange or 1.5 inch Thread Min: 2 ft (0.6 m)
Max: 9 ft 10 inch (3 m)

2A Flexible Twin Lead with weight Flange or 1.5 inch Thread Min: 3 ft 3 inch (1 m)
Max: 65 ft 7 inch (20 m)

3A Coaxial Flange or 1.5 inch Thread Min: 1 ft 3 inch (0.4 m)
Max: 19 ft 8 inch (6 m)

4A Rigid Single Lead Flange, 1 or 1.5 inch Thread Min: 2 ft (0.6 m)
Max: 9 ft 10 (3 m)

5A Flexible Single Lead with weight Flange, 1 or 1.5 inch Thread Min: 3 ft 3 inch (1 m)
Max: 65 ft 7 inch (20 m)

5B Flexible Single Lead with chuck Flange, 1 or 1.5 inch Thread Min: 3 ft 3 inch (1 m)
Max: 65 ft 7 inch (20 m)

����  ��;�	!�
���	<
��

E
M

English (feet, inch)
Metric (meters, centimeters)

���� (����	 ��;�	!�
������	7����5�8

5;7 �
���	8�� !�	��������	��	�����������	����	�!�	�����	�
���	��� �!	��	����	���	���!��	�
	����
�	���	���������
�'	�������� 	��	��������	�
���	��� �!	����	
5���	/����	��
�� 	-?�����7�	��	���"	!�� !�	��	��"��8�'	������	
����	��	��	��	����	��� �!	8!��	�
��
�� 	A	�
����	���	��	���	��	�?���	��� �!	��	������	
/�?����	����8����	��� �!	��	����
�����	��	�
�����	�����������

xx 0-65 feet or 0-20 m

���� (����	 ��;�	!�
������	7�
��5��8

xx 0-11 inch or 0-99 cm

00,/ % � / 4 / > /� * ,+ ,1 	:��+�����'��
��������;'���*�<
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Example model string: 3301-H-A-1-S-1-V-1A-M-02-05-AA-I1-M1C1.

E-02-05 in model string denotes 2ft 5 inch probe length. 

M-02-05 in model string denotes 2.05 m probe length.

����  ������	��

�����
	:	4�G�5(���	7��
����	�������	���	�����	�������	��

�����
�8

��4#	���
���	�
	0/=	44(

AA
AB
BA
BB
CA
CB
DA

2 inch ANSI, 150 lb
2 inch ANSI, 300 lb
3 inch ANSI, 150 lb
3 inch ANSI, 300 lb
4 inch ANSI, 150 lb
4 inch ANSI, 300 lb
6 inch ANSI, 150 lb

$#�	���
���	�
	0/=!	44(

HB
IA
IB
JA
JB
KA

DN50, PN40
DN80, PN16
DN80, PN40
DN100, PN16
DN100, PN40
DN150, PN16

(�������

RA
RB
SA
SB

1.5 inch NPT thread
1 inch NPT thread
1½ inch BSP (G 1½ inch) thread
1 inch BSP (G 1 inch) thread

���� %�G������	!������
�	������������
�

NA
E1
E5
E6
I1
I5
I6

No hazardous Locations Certifications
ATEX Flameproof
FM Explosion proof
CSA Explosion proof
ATEX Intrinsic Safety
FM Intrinsic Safety and Non-Incendive
CSA Intrinsic Safety and Non-Incendive

���� )����
�

M1
BT
P1
N2

Integral Digital Display
Bar Code Tag with tag number and purchase order number
Hydrostatic testing
NACE material recommendation per MR 01-75(1)

��	:	4������	��
���������
	74�������8

C1
C4
C5
C8

Factory configuration (CDS required with order)
Namur alarm and saturation levels, high alarm
Namur alarm and saturation levels, low alarm
Low alarm(2) (standard Rosemount alarm and saturation levels)

J�	:	4������	�����

Q4
Q8

Calibration Data Certification
Material Traceability Certification per EN 10204 3.1B(3)

�� #/ */�/

567 (����	��
	�
���	����	
$	���	>$�
5;7 �!�	������
�	���
�	������ 	��	!� !�
5
7 )�����	���������	��
	�
����
�	
������� 	8�����	��
��
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3302 Multivariable™ Guided Wave Radar Level and Interface Transmitter

���� 4��
��	)�����

H 4-20 mA with HART communication

���� %����
�	*�������

A Polyurethane-covered Aluminum

���� ��
����	(������5��;��	(������

1
2
3

½ - 14 NPT
M20x1.5 adapter
PG 13.5 adapter

���� )������
�	(����������	�
�	 �������

S -15 psi (-1 Bar) to 580 psi (40 Bar) @ 302 °F (150 °C) (1)

567 �
�����	����	
���� �	&����	
���� 	�������	��	���� �	���	)A
�� 	����������

���� *�������	��	��
��������

	 ������	��

�����
5 ��;�

1 316 / 316L SST (EN 1.4404), Teflon (PTFE, PFA)

���� 4����
�-	):��
�	*�������	7��
����	�������	���	�����	�:��
�	���������8

V
E
K
B

Viton
Ethylene Propylene
Kalrez 6375
Buna-N

����  ��;�	(���  ������	��

�����
  ��;�	!�
���

1A Rigid Twin Lead. Flange or 1.5 inch Thread Min: 2 ft (0.6 m)
Max: 9 ft 10 inch (3 m)

2A Flexible Twin Lead with weight Flange or 1.5 inch Thread Min: 3 ft 3 inch (1 m)
Max: 65 ft 7 inch (20 m)

3B Coaxial for interface measurements Flange or 1.5 inch Thread Min: 1ft 3 inch (0.4 m)
Max: 19 ft 8 inch (6 m)

����  ��;�	!�
���	<
��

E
M

English (feet, inch)
Metric (meters, centimeters)

���� (����	 ��;�	!�
������	7����5�8

5;7 �
���	8�� !�	��������	��	�����������	����	�!�	�����	�
���	��� �!	��	����	���	���!��	�
	����
�	���	���������
�'	������� 	��	8!��!	�
���	��� �!	����	8��	
��������	5���	/����	��
�� 	-?�����7�	��	���"	!�� !�	��	��"��8�'	������	
����	��	��	��	����	��� �!	8!��	�
��
�� 	A	�
����	���	��	���	��	�?���	��� �!	��	
������	/�?����	����8����	��� �!	��	����
�����	��	�
�����	�����������

xx 0-65 feet or 0-20 m

���� (����	 ��;�	!�
������	7�
��5��8

xx 0-11 inch or 0-99 cm

00,+ % � / 4 / > /� * ,+ ,1 	:��+�����'��
��������;'���*�<
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Example model string: 3302-H-A-1-S-1-V-1A-M-02-05-AA-I1-M1C1.

E-02-05 in model string denotes 2 ft 5 inch probe length. 

M-02-05 in model string denotes 2.05 m probe length.

����  ������	��

�����
	:	4�G�5(���	7��
����	�������	���	�����	�������	��

�����
�8

��4#	���
���	�
	0/=	44(

AA
AB
BA
BB
CA
CB
DA

2 inch ANSI, 150 lb
2 inch ANSI, 300 lb
3 inch ANSI, 150 lb
3 inch ANSI, 300 lb
4 inch ANSI, 150 lb
4 inch ANSI, 300 lb
6 inch ANSI, 150 lb

$#�	���
���	�
	0/=	44(

HB
IA
IB
JA
JB
KA

DN50, PN40
DN80, PN16
DN80, PN40
DN100, PN16
DN100, PN40
DN150, PN16

(�������

RA
SA

1.5 inch NPT thread
1½ inch BSP (G 1½ inch) thread

���� %�G������	!������
�	������������
�

NA
E1
E5
E6
I1
I5
I6

No hazardous Locations Certifications
ATEX Flameproof
FM Explosion proof
CSA Explosion proof
ATEX Intrinsic Safety
FM Intrinsic Safety and Non-Incendive
CSA Intrinsic Safety and Non-Incendive

���� )����
�

M1
BT
P1
N2

Integral Digital Display
Bar Code Tag with tag number and purchase order number
Hydrostatic testing
NACE material recommendation per MR 01-75(1)

��	:	4������	��
���������
	74�������8

C1
C4
C5
C8

Factory configuration (CDS required with order)
Namur alarm and saturation levels, high alarm
Namur alarm and saturation levels, low alarm
Low alarm(2) (standard Rosemount alarm and saturation levels)

J�	:	4������	�����

Q4
Q8

Calibration Data Certification
Material Traceability Certification per EN 10204 3.1B(3)

�� #/ */�/

567 (����	��
	�
���	����	
B�
5;7 �!�	������
�	���
�	������ 	��	!� !�
5
7 )�����	���������	��
	�
����
�	
������� 	8�����	��
��
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�.4��5�����.��� Procedures and instructions in this section may require special precautions to 
ensure the safety of the personnel performing the operations. Information that 
raises potential safety issues is indicated by a warning symbol ( ). Please 
refer to the following safety messages before performing an operation 
preceded by this symbol.

��������
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	�����	��	�������	�
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Verify that the operating environment of the gauge is consistent with the appropriate 
hazardous locations certifications.

Before connecting a HART-based communicator in an explosive atmosphere, make 
sure the instruments in the loop are installed in accordance with intrinsically safe or 
non-incendive field wiring practices.

Do not remove the gauge cover in explosive atmospheres when the circuit is alive.

�������	��	������	����	�
���������
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�������	�
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Make sure the transmitter is installed by qualified personnel and in accordance with 
applicable code of practice.

Use the equipment only as specified in this manual. Failure to do so may impair the 
protection provided by the equipment.

Do not perform any service other than those contained in this manual unless you are 
qualified.

%���	"������	����	���	;�	�����
�	�
	�����	�����	�����	����������	�����


Avoid contact with leads and terminals. 

Make sure the main power to the Radar Transmitter is off and the lines to any other 
external power source are disconnected or not powered while wiring
the gauge.
www.rosemount.com
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������
����	���+ The Rosemount 3300 Series Guided Wave Radar Level and Interface 
Transmitter that has the following label attached has been certified to comply 
with Directive 94/9/EC of the European Parliament and the Council as 
published in the Official Journal of the European Communities No. L 100/1 on 
19-April-1994.

Figure B-1. Approval Label 
ATEX (BASEEFA) and Name 
Plate

The following information is provided as part of the label of the transmitter:

• Name and address of the manufacturer (Rosemount).

• CE Conformity Marking

• Complete model number

• The serial number of the device

• Year of construction

• Marking for explosion protection:

• EEx ia IIC T4 (-50 °C ≤ Ta ≤ +70 °C)
Ui=30 V
Ii=130 mA
Pi=1 W
Ci=0, Li=0

• BASEEFA ATEX certificate number: BAS02ATEX1163X

�&���	�����������
������	���%
��C/D7

The apparatus is not capable of withstanding the 500 V test as defined in 
clause 6.4.12 of EN 50020. This must be considered during installation.

A
P

P
R

O
V

A
LS

-A
T

E
X

_B
A

S
_I

1/
N

A
M

E
P

LA
T

E

B-2



�����������	�
	��
00809-0100-4811, Rev AA
October 2002 Rosemount 3300 Series
4�	���,���� The Rosemount 3300 Series Guided Wave Radar Level and Interface 
Transmitter that has the following label attached has been certified to comply 
with Directive 94/9/EC of the European Parliament and the Council as 
published in the Official Journal of the European Communities No. L 100/1 on 
19-April-1994.

Figure B-2. Approval Label 
ATEX (KEMA) and Name Plate

The following information is provided as part of the label of the transmitter:

• Name and address of the manufacturer (Rosemount).

• CE Conformity Marking

• Complete model number

• The serial number of the device

• Year of construction

• Marking for explosion protection:

• EEx d [ia] IIC T6 (-40 °C <Ta < +75 °C)

• KEMA ATEX certificate number: KEMA 01ATEX2220
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The Rosemount 3300 Series Guided Wave Radar Level and Interface 
Transmitters that have the following labels attached have been certified to 
comply with the requirements of the approval agencies noted.

4	����+��
�
	��C4�D�
.&&���	�


Project ID: 3013394

Figure B-3. Approval Labels 
Factory Mutual (FM)

�' Explosion-Proof for Class I, Division 1, Groups B, C and D.

Dust-Ignition proof for Class II/III, Division 1, Groups E, F and G; with 
intrinsically safe connections to Class I, II, III, Div 1, Groups A, B, C, D, 
E, F AND G. 

Temperature class T5 @+85 °C.

Ambient temperature limits: -40°C to + 85°C
Factory Sealed.

�' Intrinsically Safe for Class I, II, III, Division 1, Groups A, B, C, D, E, F 
and G. 

Intrinsically Safe for Class I, Zone 0, AEX ia IIC T4 Ta=70°C.

Temperature code T4 at 70°C max ambient.

Control Drawing: 9150077-944.

Non-incendive for Class I, Division 2, Groups A, B, C and D.

Suitable for Class II, III, Division 2, Groups F and G.

Non-incendive maximum operating parameters: 42 V, 25 mA.
Temperature code T4 at 70°C max ambient.
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Cert. no. 2002.1250250.

Figure B-4. Approval Label 
Canadian Standards Association 
(CSA)

�- Explosion-Proof for Class I, Division 1, Groups C and D.

Dust-Ignition proof for Class II, Division 1 and 2, Groups G and Coal 
Dust.

Dust-Ignition proof for Class III, Division 1, Hazardous Locations 
[Ex ia IIC T6].

Ambient temperature limits: -40°C to + 85°C.
Factory Sealed.

�- Intrinsically Safe: Ex ia IIC T4. 

Intrinsically Safe for Class I, Division 1, Groups A, B, C and D.

Temperature code T4.

Control Drawing: 9150077-945.

Non-incendive for Class III, Division 1, Hazardous Locations.

Non-incendive for Class I, Division 2, Groups A, B, C and D.

Ambient temperature limits: -40 °C to + 70 °C.

A
P

P
R

O
V

A
LS

-C
S

A
_E

6,
 C

S
A

_I
6

B-5



�����������	�
	�
00809-0100-4811, Rev AA

October 2002Rosemount 3300 Series
.,,��6.��*�.����� This section contains Factory Mutual installation drawings and Canadian 
Standards installation drawings. You must follow the installation guidelines 
presented in order to maintain certified ratings for installed transmitters. 

This section contains the following drawings:

Saab Rosemount drawing 9150077-944, Issue 1:

System Control Drawing for hazardous location installation of intrinsically safe 
FM approved apparatus.

Saab Rosemount drawing 9150077-945, Issue 1:

System Control Drawing for hazardous location installation of CSA approved 
apparatus.
B-6
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Figure B-5. System Control Drawing for hazardous location installation of intrinsically safe FM approved apparatus.
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Figure B-6. System Control Drawing for hazardous location installation of CSA approved apparatus.
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���	���
������
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	(�
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����������
� �3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3 &	(���$'
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���4�	�
��
� �3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3 &	(���$-
���

�	���4
������
�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3�3 &	(���$9

�����*%����� This appendix provides an introduction to using the HART Communicator with 
the Rosemount Model 3300 transmitter, including the HART Communicator 
keypad, connections, menu structure and Fast Key sequence features.

The HART Communicator manual provides detailed instructions on the use 
and features of the HART Communicator. This brief summary will familiarize 
you with the HART Communicator but is not meant to replace the HART 
Communicator manual. For information on all the capababilities of the HART 
Communicator, refer to the HART Communicator Product Manual (document 
00809-0100-4275).

�.4��5�����.��� Procedures and instructions in this section may require special precautions to 
ensure the safety of the personnel performing the operations. Information that 
raises potential safety issues is indicated by a warning symbol ( ). Please 
refer to the following safety messages before performing an operation 
preceded by this symbol.

��������
�	�����	������	�
	�����	��	�������	�
����


Verify that the operating environment of the gauge is consistent with the appropriate 
hazardous locations certifications.

Before connecting a HART-based communicator in an explosive atmosphere, make 
sure the instruments in the loop are installed in accordance with intrinsically safe or 
non-incendive field wiring practices.

Do not remove the gauge cover in explosive atmospheres when the circuit is alive.
www.rosemount.com
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�������	��	������	����	�
���������
	�
�	���"���
�	�������
��	�����	������	�
	�����	��	
�������	�
����


Make sure only qualified personnel perform the installation.

Use the equipment only as specified in this manual. Failure to do so may impair the 
protection provided by the equipment.

Do not perform any service other than those contained in this manual unless you are 
qualified.

��	�	������	��	�����
�-	���	*����	00,,	���
�������	�
�	���	�����	�M�����
�	�
	����	
��
�	������	;�	����	���	�����	��	�
����
�	���	��
��
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Figure C-1. HART Communicator Menu Tree
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Table C-1.  HART Fast Key Sequences

��
����
 %��(	����	I��

Construction Materials 1, 4, 1, –

Device Information 1, 4, 1

Display Language 1, 4, 2, 2

Display Variables 1, 4, 2, 1

Level Units 1, 3, 2, 1

Loop Test 1, 2, 2

Lower Range Value (LRV) (4 mA) 1, 3, 3

Master Reset 1, 2, 1, 2

Measurement Mode 1, 3, 9

Poll Address 1, 4, 5, 2, 1

Primary Variable 1, 1, 1, 1

Probe Length 1, 3, 5

Probe Type 1, 3, 6

Process Variable Damping 1, 4, 4, 4

Product Dielectric 1, 3, 8

Range Values 1, 3, 3, 2

Reference Gauge Height 1, 3, 4

Strapping Table 1, 4, 3, 4

Tag 1, 3, 1

Tank Type 1, 4, 3, 1

Tank Diameter 1, 4, 3, 2

Temperature Units 1, 3, 2, 3

Upper Null Zone 1, 4, 4, 5

Upper Range Value (URV) (20 mA) 1, 3, 3

Vapor Dielectric 1, 3, 7

Variable Remapping 1, 1, 1, 1

Volume Units 1, 3, 2, 2
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����������� The HART Communicator exchanges information with the 3300 Series 
transmitters from the control room, the instrument site, or any wiring 
termination point in the loop. The HART Communicator should be connected 
in parallel with the transmitter. Use the loop connection ports on the rear panel 
of the HART Communicator (see Figure C-2). The connections are 
non-polarized. 

Do not make connections to the serial port or NiCad recharger pack in an 
explosive atmosphere.

Figure C-2. Rear connection 
panel with Optional NiCad 
Recharger Jack

Before connecting the HART Communicator in an explosive atmosphere, 
make sure the instruments in the loop are installed in accordance with 
intrinsically safe or non-incendive field wiring practices. 

����
The HART Communicator needs a minimum of 250 ohms resistance in the 
loop to function properly. The HART Communicator does not measure loop 
current directly.

����
Loop must be broken to insert the 250 ohm load resistor.

!���	��

�����
	 ����

)����
��	�����	
���������	K���

4�����	 ���

00
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0.����4�.�%��� The keys of the HART Communicator include action keys, function keys, 
alphanumeric keys, and shift keys.

Figure C-3. 275 HART 
Communicator

.������G�+


As shown in Figure C-3, the action keys are the six blue, white, and black 
keys located above the alphanumeric keys. The function of each key is 
described as follows

��A�44�G�+�

Use this key to power the HART Communicator. When the communicator is 
turned on, it searches for a gauge on the 4–20 mA loop. If a device is not 
found, the communicator displays the message, “No Device Found. Press 
OK.” 

If a HART-compatible device is found, the communicator displays the Online 
Menu with device ID and tag. 

If a HART-compatible device is found, the communicator displays the Online 
Menu with device ID and tag. 

*��������	��G�+


Use these keys to move the cursor up, down, left, or right. The right arrow key 
also selects menu options, and the left arrow key returns to the previous 
menu.

��
����
	I���

�����
	I���

�����
������	I���

4����	I���

01
1A

B
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1���G�+

Use this key to quickly access important, user-defined options when
connected to a HART-compatible device. Pressing the Hot Key turns
the HART Communicator on and displays the Hot Key Menu. 
See Customizing the Hot Key Menu in the HART Communicator manual for 
more information.

4
�������G�+


Use the four software-defined function keys, located below the LCD, to 
perform software functions. On any given menu, the label appearing above a 
function key indicates the function of that key for the 
current menu. 

As you move among menus, different function key labels appear over the four 
keys. For example, in menus providing access to online help, the  label 
may appear above the F1 key. In menus providing access to the Home Menu, 
the  label may appear above the F3 key. Press the key to activate the 
function. See the HART Communicator manual for details on specific 
Function Key definitions.

.�&)	�
������	����)��� G�+


The Alphanumeric keys perform two functions: fast selection of menu options 
(refer to HART Fast Key Feature in this section) and data entry.

Figure C-4. HART 
Communicator Alphanumeric 
and Shift Keys

Some menus require data entry. Use the Alphanumeric and Shift keys to enter 
all alphanumeric information into the HART Communicator. If you press an 
Alphanumeric key alone from within an edit menu, the bold character in the 
center of the key appears. These large characters include the numbers zero 
through nine, the decimal point (.), and the dash symbol (–).

To enter an alphabetic character:

1. Press the Shift key that corresponds to the position on the Alphanumeric 
key of the letter you want.

2. Press the Alphanumeric key.

5!6�

5-
!
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For example, to enter the letter R, first press the right Shift key, then the “6” 
key (see Figure C-5). Do not press these keys simultaneously, but one after 
the other.

Figure C-5. Data Entry Key 
Sequence

���%��.�*�
4%�������

The HART Communicator is a menu driven system. Each screen provides a 
menu of options that can be selected or provides direction for input of data, 
warnings, messages, or other instructions. 

�	������


When the HART Communicator is turned on, one of two menus appears: the 
Online Menu or the Main Menu.

If the HART Communicator is connected to an operating loop, the 
communicator finds the device and displays the Online Menu.

If it is not connected to a loop, the communicator indicates that no device was 
found. When you press OK (F4), it displays the Main Menu.

 The Main Menu provides the following options:

• 4������ – The Offline option provides access to offline configuration data 
and simulation functions.

• 4�����	– The Online option checks for a device and if it finds one, 
brings up the Online Menu. Online communication with the 3300 Series 
Transmitter automatically loads the current gauge data to the HART 
Communicator.

• ��������	– The Transfer option provides access to options for 
transferring data either from the HART Communicator (memory) to the 
3300 Series Transmitter (device) or vice versa. Transfer is used to 
move offline data from the HART Communicator to the gauge, or to 
retrieve data from a gauge for offline revision. 

• 5��6����+	�� ���	– The Frequency Device option displays the 
frequency output and corresponding pressure output of 
current-to-pressure transmitters.

• 7�����+	– The Utility option provides access to the contrast control for the 
HART Communicator LCD screen and to the autopoll setting used in 
multidrop applications. 

To select an option from the menu, you can use the up and down 
arrow keys and the select (right arrow) key or you can simply press 
the corresponding number on the alphanumeric keypad to “fast select” the 
option.

-
,�H��
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After selecting a Main Menu option, the HART Communicator provides the 
information you need to complete the operation. If further details are required, 
consult the ,2.�	0����������� manual.

����������


The Online Menu can be selected from the Main Menu or it appears 
automatically if the HART Communicator is connected to an active
loop and can detect an operating 3300 transmitter. 

Online mode is used for direct evaluation of a particular meter, 
re-configuration, changing parameters, maintenance, and other functions. 

When configuration variables are reset in online mode, the new 
settings are not activated until the data is sent to the gauge. Press SEND (F2) 
when it is activated to update the process variables of the 3300 transmitter. 

����
The Main Menu can be accessed from the Online Menu. Press the left arrow 
action key to deactivate the online communication with the gauge and to 
activate the Main Menu options.

1.���4	
��G�+�4�	�
��

The HART Fast Key feature provides quick online access to gauge variables 
and functions. Instead of stepping your way through the menu structure using 
the Action Keys, you can press a HART 
Fast Key sequence to move from the Online Menu to the desired variable or 
function. On-screen instructions guide you through the 
rest of the screens.

The HART Fast Key sequences are made up of the series of numbers 
corresponding to the individual options in each step of the menu structure. For 
example, from the Online Menu you can change the *	��. Following the 
menu structure, you would:

1. Press 1 to reach *���������
&.

2. Press 4 for *��	��������
&. 

3. Press 1 for *������������	����. 

4. Press 5 for *	��. 

So, the corresponding HART Fast Key sequence is  , #,  , '.

HART Fast Keys are operational only from the Online Menu. If you use them 
consistently, you return to the Online Menu by pressing HOME (F3) when it is 
available. If you do not start at the Online Menu, the HART Fast Keys will not 
function properly.

Use Table C-1, an alphabetical listing of online functions, to find the 
corresponding HART Fast Keys. These codes are applicable only to the 3300 
Series and the HART Communicator.

1	�������
���	����
*�	(��
������

	(�


The following table is a list of messages used by the HART Communicator 
and their corresponding descriptions.

Variable parameters within the text of a message are indicated with 8 �������	
�����9.

Reference to the name of another message is identified by 8�����
�9.
C-9
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Table C-2.  HART Communicator Diagnostic Messages
*������ $���������


���	����	���	�!!	��"���	�����	��	
�
��	���	����	)��	��"���	�����

Asks the user whether the hot key item being added should be added for all device types or only for 
the type of device that is connected.

�����
�	���	#������
��� The connected device does not support this function.

�����
������
	����� Either a device sends back a response indicating that the message it received was unintelligible, or 
the HC cannot understand the response from the device.

��
���������
	������	
��	
�������;��	����	��

�����	

��"���

The configuration stored in memory is incompatible with the device to which a transfer has been 
requested.

$�"���	3��� The connected device is busy performing another task.
$�"���	$����

����� Device fails to respond to a command.

$�"���	�����	��������� Device is in write-protect mode. Data can not be written.

$�"���	�����	����������	
$�	���	�����	��
�	��	����	���N

Device is in write-protect mode. Press YES to turn the HC off and lose the unsent data.

$������	"����	��	"����;��	�
	

������ ��
�N

Asks whether the value of the variable should be displayed adjacent to its label on the hotkey menu if 
the item being added to the hotkey menu is a variable.

$��
����	����	����	

��
���������
	������	��	��"���

Prompts user to press SEND softkey to initiate a memory to device transfer.

������	�����	����� Indicates that the field width for the current arithmetic variable exceeds the device-specified 
description edit format.

������	��������
 Indicates that the precision for the current arithmetic variable exceeds the device-specified 
description edit format.

�����	��"���	���	�����
����
��	
���	��	�	%�������	�����	��	

�������

The 3300 transmitter may simply be configured incorrectly (20 mA point in upper Null Zone, etc.) 
Verify the configuration.

#�
���	
���	1,	�������
���	

�� ������N

Asked after displaying device status. Softkey answer determines whether next 50 occurrences of 
device status will be ignored or displayed.

#������	��������� An invalid character for the variable type was entered.
#������	���� The day portion of the date is invalid.

#������	��
�� The month portion of the date is invalid.

#������	���� The year portion of the date is invalid.

#
��������	����
�
� The exponent of a scientific notation floating point variable is incomplete.

#
��������	����� The value entered is not complete for the variable type.

!����
�	���	�	��"��� Polling for multidropped devices at addresses 1–15.
*���	��	����	�
��	"����;��	�
	

������	��
�N

Asks whether the user should be allowed to edit the variable from the hotkey menu if the item being 
added to the hotkey menu is a variable.

��	��"���	��
���������
	�
	
��
���������
	������

There is no configuration saved in memory available to re-configure offline or transfer to a device.

��	$�"���	���
� Poll of address zero fails to find a device, or poll of all addresses fails to find a device if auto-poll is 
enabled.

��	������	��
�	�"����;��	���	

���� ��"����

There is no menu named “hotkey” defined in the device description for this device.

��	�����
�	��"���� �"����;��� There are no device descriptions available to be used to configure a device offline.

��	���������
	��"���� �"����;��� There are no device descriptions available to simulate a device.

��	< !)�$O>��#�3!�4	�
	���	

���	����	��"���

There is no menu named “upload_variables” defined in the device description for this device. This 
menu is required for offline configuration.

��	>����	#���� The selected menu or edit display contains no valid items.

)��	I�P	$#4�3!�$ Appears when the user attempts to turn the HC off before sending modified data or before 
completing a method.

)
��
�	��"���	�����

�����	����	

�
��
�	�����	��(�P	��	)I	��	
����	�����

There is unsent data for a previously connected device. Press RETRY to send data, or press OK to 
disconnect and lose unsent data.

)��	��	������	���	������	
��
���������
�	$�����	

�

��������	������

There is no more memory available to store additional hotkey items. Unnecessary items should be 
deleted to make space available.
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)"�������	������
�	
��
���������
 ������

Requests permission to overwrite existing configuration either by a device-to-memory transfer or by 
an offline configuration. User answers using the softkeys.

 ����	)I��� Press the OK softkey. This message usually appears after an error message from the application or 
as a result of HART communications.

�������	��"���	"����N The edited value that was sent to a device was not properly implemented. Restoring the device value 
returns the variable to its original value.

4�"�	����	����	��"���	��	
��
���������
	������

Prompts user to press SAVE softkey to initiate a device-to-memory transfer.

4�"�
�	����	��	
��
���������
 �������

Data is being transferred from a device to configuration memory.

4�
��
�	����	��	��"���� Data is being transferred from configuration memory to a device.

(����	���	�����	�
��	"����;���	
�����	��"�	
��	;��
	�������	
 �����	���� �����

There are write-only variables which have not been set by the user. These variables should be set or 
invalid values may be sent to the device.

(����	��	�
��
�	�����	4�
�	��	

;�����	������
� ���N

Press YES to send unsent data and turn the HC off. Press NO to turn the HC off and lose the unsent 
data.

(��	���	����	;���� �����"�� Command returns fewer data bytes than expected as determined by the device description.

(��
�������	����� Device returns a command response indicating a fault with the connected device.

<
���	���	Q"����;��	��;��B	���	
���
����	<
��	����	;�	��
�	

;�����	�����
�-	��	�
"����	����	����	
;�	��
��

The engineering units for this variable have been edited. Send engineering units to the device before 
editing this variable.

<
��
�	����	��	�
��
�	��"����	
4��$	��	!)4� ����

There is unsent data for a previously connected device which must be sent or thrown away before 
connecting to another device.

<��	��5���
	������	��	���
��	
��
������	 ����	$)��	���
	

��
��

Gives direction to change the contrast of the HC display.

>����	���	��	��
�� The user-entered value is either not within the range for the given type and size of variable or not 
within the min/max specified by the device.

Q�������B	��������	
�����
�5�����
�	Q"����;�� ��;��B

Either a read/write command indicates too few data bytes received, transmitter fault, invalid response 
code, invalid response command, invalid reply data field, or failed pre- or post-read method; or a 
response code of any class other than SUCCESS is returned reading a particular variable.

Q"����;��	��;��B	���	�
	�
�
��
	

"�����	<
��	����	;�	��
�	;�����	
�����
�-	��	�
"����	����	����	;�	
��
��

A variable related to this variable has been edited. Send related variable to the device before editing 
this variable.

Table C-2.  HART Communicator Diagnostic Messages
*������ $���������
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20 mA point . . . . . . . . . . . . . . 4-4
4 and 20 mA Points  . . . . . . . 4-12
4 mA point  . . . . . . . . . . . . . . 4-4

.
Action Keys

Up Arrow Key . . . . . . . . .C-6
Alarm switch  . . . . . . . . . . . . . 3-5
Amplitude Threshold Settings  6-13
Analog Output

alarm values . . . . . . . . . . 3-4
saturation values . . . . . . . 3-4

Analog Output calibration  . . . . 6-9
Anchoring . . . . . . . . . . . . . . 3-14
Applications  . . . . . . . . . . . . . 2-2
Approval Drawings . . . . . . . . . B-6
Approvals . . . . . . . . . . . . . . . B-1
Atex . . . . . . . . . . . . . . . . . . . B-2

0
Bridging  . . . . . . . . . . . . . . . . 2-8
Burst mode . . . . . . . . . . . . . 4-25
Burst option . . . . . . . . . . . . . 4-25

�
Cable Selection . . . . . . . . . . 3-16
Cable/conduit entries . . . . . . 3-16
Calibration Offset . . . . . . . . . . 6-2
Canadian Standards Association

approval . . . . . . . . . . . . . B-5
system control drawing  . . B-8

Changing the Probe . . . . . . . 6-11
Coating . . . . . . . . . . . . . . . . . 2-8
COM Port . . . . . . . . . . . . . . 4-14
Configuration . . . . . . . . . . . . . 4-2

basic  . . . . . . . . . . . . . . . 4-2
HART communicator . . . . 4-7
volume . . . . . . . . . . . . . . 4-5

*
Damping . . . . . . . . . . . 4-11, 6-7
Dead Zones  . . . . . . . . . . . . . 2-7
Dielectric Calculator . . . . . . . 4-21
Dielectric Chart  . . . . . . . . . . 4-21

Dielectric Constant
Upper Product  . . . . . . . . 4-3
Vapor  . . . . . . . . . . . . . . 4-3

Display
Alarm  . . . . . . . . . . . . . . 5-2
Write Protection  . . . . . . . 5-2

Display panel  . . . . . . . . . . . . 5-1
Disturbances

Upper Null Zone . . . . . . 6-12

�
Electrical installation  . . . . . . 3-16

connecting the transmitter 3-18
Intrinsically Safe Output . 3-19
Non-Intrinsically Safe Output 3-18
Tri-Loop . . . . . . . . . . . . 3-20

Emulsion layers  . . . . . . . . . 2-10
European ATEX Directive Information 
B-2

4
Factory Mutual

approval  . . . . . . . . . . . . B-4
system control drawing  . . B-7

Fast Key Feature  . . . . . . . . . C-8
Fast Key Sequence Table  . . . C-4
Flange Connection  . . . . . . . . 3-7
Foam . . . . . . . . . . . . . . . . . . 2-8
Function Keys . . . . . . . . . . . . C-7
Functions . . . . . . . . . . . . . . . C-8

�
Grounding  . . . . . . . . . . . . . 3-16

1
HART Communicator

alphanumeric keys  . . . . . C-7
connecting . . . . . . . . . . . C-5
connections and hardware C-5
fast key feature . . . . . . . . C-8
fast key sequence table . . C-4
function keys  . . . . . . . . . C-7
functions  . . . . . . . . . . . . C-8
main menu . . . . . . . . . . . C-8
menus . . . . . . . . . . . . . . C-8
menus and functions . . . . C-8

online menu . . . . . . . . . . C-9
shift keys . . . . . . . . . . . . C-7

Hazardous Locations Certifications 
B-4
High Level Rates  . . . . . . . . . .6-7

�
Installation

cable selection . . . . . . . .3-16
cable/conduit entries  . . .3-16
flange connection . . . . . . .3-7
Free Space . . . . . . . . . . .3-9
grounding  . . . . . . . . . . .3-16
mounting considerations . .3-6
power requirements  . . . .3-17
procedure  . . . . . . . . . . . .3-3
recommended mounting position 

3-10
shortening the probe  . . .3-12
Still pipes  . . . . . . . . . . . .3-8
threaded connection . . . . .3-6

Integral display . . . . . . . . . . . .5-1
Interface  . . . . . . . . . . . . . . . .2-9

fully immersed probes . . . .6-8
low dielectric constants . . .6-5

�
Level and Distance Calibration 6-10
Lower Dead Zone . . . . . . . . . .2-7

�
Maximum load resistance 3-18, 3-19
Maximum Upper Product Thickness 
4-11
Measurement Mode  . . . . . . . 4-11
Measurement Principle  . . . . . .2-1
Measuring range  . . . . . . . . . .2-8
Memory Map  . . . . . . . . . . . .6-17
Menus . . . . . . . . . . . . . . . . . C-8
Multidrop connection . . . . . . .3-21

�
NAMUR-Compliant Alarm  . . . .3-4
Nozzle

maximum height  . . . . . . .3-7
minimum diameter  . . . . . .3-7
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Probe Angle  . . . . . . . . . . . . 4-11
Probe angle  . . . . . . . . . . . . . 4-4
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Probe Type . . . . . . . . . 4-3, 4-10
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Radar Configuration Tool  . . . 4-14
RCT . . . . . . . . . . . . . . . . . . 4-14

COM Port . . . . . . . . . . . 4-14
installing . . . . . . . . . . . . 4-14
Logging  . . . . . . . . . . . . 6-15
Logging the plot  . . . . . . . 6-4
Saving the configuration . 6-16
Setup . . . . . . . . . . . . . . 4-17
Waveform Plot  . . . . . . . . 6-3
Wizard . . . . . . . . . . . . . 4-16

Recommended mounting position  .
3-10
Reference Gauge Height  4-3, 4-9

�
Setup

Basic . . . . . . . . . . . . . . 4-18
LCD . . . . . . . . . . . . . . . 4-23
Output  . . . . . . . . . . . . . 4-19
Save configuration . . . . . 6-16
Tank Config  . . . . . . . . . 4-20
Volume  . . . . . . . . . . . . 4-22

Shift Keys . . . . . . . . . . . . . . .C-7
Standard Tank Shapes . . . . . . 4-6
Strapping Table . . . . . . . . . . 4-13
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Tank connection
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